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1 Introduction 

1.1  About this manual 

This manual is structured in line with the logical chain of configuration operations 
required to get GFI EventsManager up and running. 

Chapter Description 

Chapter 1 Introduction 

An overview of this manual and how GFI EventsManager works. 

Chapter 2 Installation 

Describes how to install GFI EventsManager, including system requirements, pre-
install actions required and how to upgrade from previous versions. 

Chapter 3 Getting Started 

Shows how to configure GFI EventsManager for first time use, including how to 
configure the database backend and how to process event logs for the first time. 

Chapter 4 Event browsing 

Explains how to use the built-in events browser to analyze events stored in the 
GFI EventsManager database backend, including: 

 Default event log queries and custom query builder 

 Event color-coding 

 Event finder tool. 

Chapter 5 Generating reports 

Describes how to enable the GFI EventsManager ReportPack to create reports 
that further analyze the events stored in the GFI EventsManager database 
backend. 

Chapter 6 Customizing event sources 

Shows how to customize the event sources to be monitored. 

Chapter 7 Using event processing rules 

Explains how to use event processing rules. 

Chapter 8 Managing event processing rules 

Describes how to create, edit and delete event processing rules. 

Chapter 9 Customizing alerts and actions 

Shows how to set the alerts and actions that will be triggered on particular events. 

Chapter 10 Configuring users and groups 

Explains how to configure alert recipient parameters including: 

 Personal details such as mobile phone number 

 Normal working hours 

 Type of alerts that will be sent to every recipient. 
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Chapter Description 

Chapter 11 Status monitoring 

Describes how to analyze the status of GFI EventsManager as well as view 
statistical information and processed events. 

Chapter 12 Database Operations 

Explains how to centralize events collected by other remote GFI EventsManager 
instances and how to optimize database backend performance. 

Chapter 13 Miscellaneous 

Describes miscellaneous options such as permissions, command line operations 
and licensing. 

Chapter 14 Troubleshooting 

Explains what main sources of information are available to help administrators 
troubleshoot product issues. 

Chapter 15 Glossary 

Defines technical terms used within GFI EventsManager. 

1.2  Conventions used in this manual 

The following table contains a description of the common terms and conventions 
used in this manual: 

Term Description 

 

Additional information and references essential for the operation of GFI 
EventsManager. 

   
Important notifications and cautions regarding potential issues that are 
commonly encountered. 

► Step by step navigation instructions to access a function. 

Bold text Indicate a control within the user interface, such as nodes, menus and 
buttons. 

<Italic text> Replace text within angle brackets. Such as file paths and custom parameters. 

Indented code The indented text indicates that the text is a programming code. In some 
programming languages indentation is important. 

For any technical terms and their definitions as used in this manual, refer to Glossary 
chapter in this manual. 
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1.3  About GFI EventsManager 

 
Figure 1 - GFI EventsManager integrates into any existing IT infrastructure 

GFI EventsManager is a results oriented event log management solution which 
integrates into any existing IT infrastructure, automating and simplifying the tasks 
involved in network-wide events management. 

Through the features supported by GFI EventsManager you can: 

 Automatically collect W3C, Syslog, SNMP Traps and Windows events from 
network devices and Windows/Linux/Unix based systems and manage them 
through one console. 

 Archive collected events in a centralized SQL Server based database backend 
for future analysis and forensic studies. 

 Automatically transfer events from the database to external files. 

 Filter unwanted events and classify key events through the use of powerful 
default or custom-built event processing rules. 

 Automate alerting and remedial actions such as the execution of scripts and files 
on key events. 

 Monitor your network activity and the status of your GFI EventsManager scanning 
engine through a built-in graphical dashboard. 

 Analyze events through a built-in events browser as well as export these events 
to CSV files for further processing and report customization. 

 Simplify event forensics through specialized tools which include a built-in event 
query builder, an event finder tool and an event color-coding tool. 

 Increase event processing power through a high-performance event scanning 
engine. 
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 Generate, schedule as well as email event activity and trend reports through GFI 
EventsManager ReportPack - the powerful reporting companion tool which ships 
by default with GFI EventsManager. 

 Monitor the operational health status of your SQL Servers in real-time by 
processing the activity logs/messages generated by day-to-day SQL Server 
operations. 

1.4  Key Features 

Extended event log support 

GFI EventsManager is able to process various event log types including Windows 
Event Logs, W3C logs, Syslog and SNMP Trap messages. This allows you to collect 
more data from the different hardware and software systems that are most commonly 
available on a typical corporate network. For a summary list of hardware and 
software systems that are supported by GFI EventsManager out of-the-box refer to: 
http://kbase.gfi.com/showarticle.asp?id=KBID003302. 

Rule-based event log management 

GFI EventsManager ships with a pre-configured set of event processing rules that 
allow you to filter and classify events collected from a variety of event-log sources. 
You can run these default rules without performing any configuration or you can 
choose to customize these rules or create tailored ones that suite your network 
infrastructure. For a list of event-log sources that can be processed by GFI 
EventsManager out-of-the-box refer to: 

http://kbase.gfi.com/showarticle.asp?id=KBID002868. 

Event log scanning profiles 

GFI EventsManager allows you to organize event log scanning rules into Scanning 
Profiles. In a scanning profile, you can configure the set of event log monitoring rules 
that will be applied to a specific computer or group of computers. The benefits of 
these profiles include: 

 The simplification product administration tasks by providing a centralized way of 
tuning event processing rules. 

 Allowing administrators to create different sets of event log rules that suit the 
roles of scanned event sources and the corporate network environment. For 
example, you can setup a set of rules which apply only to workstations in a 
particular department. 

Allow granular configuration of rules 

Administrators can create an event processing profile that is generic for all computers 
and a number of separate profiles which complement the generic profile by providing 
additional and more specialized event log rules on a computer by computer basis. 

http://kbase.gfi.com/showarticle.asp?id=KBID003302
http://kbase.gfi.com/showarticle.asp?id=KBID002868
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Translates cryptic Windows events 

One major drawback of Windows Event Logs is that they are not user friendly - too 
cryptic for the user to understand. In fact this is one of the main reasons why only few 
administrators really peer into Windows Event Logs. GFI EventsManager overcomes 
this problem by translating event descriptions into a way that is more users friendly 
and easier to understand. 

Enhanced event scanning engine 

GFI EventsManager includes an event scanning engine that has been tuned to 
effectively speed up event scanning for maximum performance. This engine adopts a 
plug-in based concept that allows the plugging-in of additional features/modules 
without having to perform physical changes to the existing code - hence more 
stability without effecting scalability. 

Automatic noise reduction 

GFI EventsManager identifies and removes unwanted event data (such as noise and 
background process generated events) providing you with only the relevant, usable 
data. Hence facilitates event forensics by reducing the amount of events to be 
analyzed. 

Enhanced real-time actions 

GFI EventsManager can generate alerts or trigger actions such as script execution 
when key events are detected. You can alert one or more people in various ways 
including: email, network messages, and SMS notifications sent through an email-to-
SMS gateway or service. Actions can be configured to trigger on event classification 
or by configuring specific conditions in event processing rules. 

Advanced event filtering features 

GFI EventsManager ships with a number of event filtering features including: 

 Pre-configured event queries and a custom event query builder: The pre-
configured event queries allow you to sift event log data and browse only the 
required events - without deleting any records from your database backend. The 
built-in event query builder allows you to create your own custom event queries. 

 Event color-coding capabilities: Through this feature you can selectively color 
particular events in specific colors. This way during log browsing you can easily 
identify important events through their color. 

 Event finder tool: With this tool you can quickly locate important events by 
providing specific search criteria such as event type. 
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Event centralization 

GFI EventsManager enables you to monitor and manage events generated by 
Windows\Linux\Unix systems, network devices and software applications through a 
single user console. 

User access privileges 

GFI EventsManager allows you to assign management console access privileges on 
a user-by-user basis. This means that you can allow specific users to access the GFI 
EventsManager console for event-browsing only and at the same time allow other 
more privileged users to access and change the GFI EventsManager configuration 
settings. 

SQL Server audit 

GFI EventsManager allows you to automatically monitor the operational health status 
of your SQL Servers. This is achieved by processing in real-time the activity 
logs/messages generated by day-to-day SQL Server operations. SQL server activity 
that is monitored includes server startup, login activity, backups, server-side traces 
and more. Additionally, GFI EventsManager can also alert you via email, network or 
SMS notifications on key events like server shutdown and consecutive failed logins. 

Database operations (WAN Connector) 

The Database Operations module allows you to collect events data from GFI 
EventsManager installations on multiple sites and locations across your network into 
a central database. This add-on integrates and centralizes events collected and 
processed and allows you to backup/restore events on demand. Through Database 
Operations you can manage the size of the database - without the need for manual 
intervention - not only through centralization but by also being able to export events 
and back them up as needed. 

Management Information Base 

Management Information Base (MIBs) contain definitions and device information that 
are provided by device manufacturers. GFI EventsManager ships with MIB definitions 
for the following vendors: Cisco, 3Com, IBM, HP, Check Point, Alcatel, Dell, Netgear, 
SonicWall, Juniper Networks, Arbor Networks, Oracle, Symantec, Allied Telesis and 
others. GFI EventsManager also allows you to edit the MIB tree. 
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1.5  How does GFI EventsManager work? 

 
Figure 2 - The GFI EventsManager operational stages  

The operational functionality of GFI EventsManager is divided into 2 stages: 

 Stage 1: Event Collection 



 

8  Introduction GFI EventsManager manual 

 Stage 2: Event Processing 

A description of every stage is provided below. 

Stage 1: Event Collection 

During the Event Collection stage, GFI EventsManager collects logs from specific 
event sources. This is achieved through the use of 2 event collection engines: The 
Event Retrieval Engine and the Event Receiving Engine. 

The Event Retrieval Engine - The Event Retrieval Engine is used to collect 
Windows Event Logs and W3C logs from networked event sources. During the Event 
Collection process this engine will: 

1. Log-on to the event source(s) 

2. Collect events from the source(s) 

3. Send collected events to the GFI EventsManager Server 

4. Log-off from the event source(s). 

The Event Retrieval Engine collects events at specific time intervals. The event 
collection interval is configurable from the GFI EventsManager management console. 

The Event Receiving Engine - The Event Receiving Engine acts as a Syslog and 
an SNMP Traps server; it listens and collects Syslog and SNMP Trap 
events/messages sent by various sources on the network. As opposed to the Event 
Retrieval Engine, the Event Receiving Engine receives messages directly from the 
event source; therefore it does not require to remotely log-on to the event sources for 
event collection. Further to this, Syslog and SNMP Trap events/messages are 
collected in real-time and therefore no collection time intervals need to be configured. 

By default, the Event Receiving Engine listens to Syslog messages on port 514 and 
to SNMP Trap messages on port 162. Both port settings are however customizable 
via the GFI EventsManager management console. 

Stage 2: Event Processing 

During this stage, GFI EventsManager will run a set of Event Processing Rules 
against collected events. Event Processing rules are instructions that: 

 Analyze the collected logs and classify processed events as Critical, High, 
Medium, Low or Noise (unwanted or repeated events) 

 Filter events that match specific conditions 

 Trigger email, SMS and network alerts on key events 

 Trigger remediation actions such as the execution of executable files or scripts on 
key events 

 Optionally archive collected events in the database backend. 
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GFI EventsManager can be configured to archive events without running Event 
Processing rules. In such cases, even though no rules will be applied against 
collected logs, archiving will still be handled by the Event Processing stage. 

After processing the rules, GFI EventsManager can be configured to store the 
collected events in a storage folder. The administrator can configure the path of the 
storage folder and configure which events are stored. This function will minimize 
database growth, and allows the administrator to store only important events in the 
database. 

1.6  Operational privileges 

Some of the key modules in GFI EventsManager must run under administrative 
privileges. For more information on these modules refer to: 
http://kbase.gfi.com/showarticle.asp?id=KBID001122. 

1.7  Navigating the GFI EventsManager management console 

 
Screenshot 1 - The GFI EventsManager management console  

Section Description 

 

Status option - Use this option to view the status of GFI EventsManager and statistical 

information on processed logs. 

 

Configuration option - Use this option to access and configure the main event 

processing options. 

http://kbase.gfi.com/showarticle.asp?id=KBID001122
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Section Description 

 

Events Browser - Use this option to browse the events stored in the GFI EventsManager 

database backend. 

 

Reporting - Use this option to download and install the GFI EventsManager ReportPack. 

 

General options - Use this option to check for product updates, as well as view version 

and licensing details.3 

 

Tab options - Use the Tab options to access and configure GFI EventsManager 

operational parameters. 

 

Group Type - Use this drop-down to switch between event log source groups (i.e. 

Computer and Database Servers Groups). 

 

Left pane - Use this pane to navigate through the additional configuration options 
provided in GFI EventsManager. 

 

Right pane - Event browsing and parameter configuration pane. 
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2 Installation 

2.1  Introduction 

Where can I install GFI EventsManager on my network? 

GFI EventsManager can be installed on any computer which meets the minimum 
system requirements irrespective of the location on your network. 

Use GFI EventsManager to manage the events generated: 

 On the same computer where it is installed 

 On all the computers that are reachable from the computer on which it is 
installed. 

 
Figure 3 - GFI EventsManager deployment scenario 

GFI EventsManager can be deployed: 

1. Within your network to monitor the activity of internal servers and workstations/end 
points. 

2. On the DMZ to monitor and manage the events generated on your servers. 
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2.1.1 Deployment of GFI EventsManager on a local area 
network 

GFI EventsManager can be deployed on Windows based networks as well as on 
mixed environments where Linux and UNIX systems are being used as well. 

 
Figure 4 - Deployment of GFI EventsManager on LAN 

When installed on a Local Area Network (LAN) GFI EventsManager can manage 
Windows events, W3C event logs, Syslog messages, SNMP Trap and SQL Server 
audit messages generated by any hardware or software that is connected to the 
LAN, including: 

 Workstations and Servers (e.g. Apache web-servers) 

 Network appliances (e.g. Cisco PIX firewalls) 

 Third party software (e.g. GFI EndPointSecurity) 

 Specialized Services (e.g. Microsoft Internet Information Server - IIS) 

 PABXs, Keyless Access Systems, Intrusion detections systems, etc. 

When installed on a LAN, GFI EventsManager can also be used to collect events 
from hardware and software systems deployed on a Demilitarized Zone (DMZ). Since 
a firewall or a router usually protects this zone with network traffic filtering 
capabilities, you must make sure that: 

1. The communication ports used by GFI EventsManager are not blocked by the 
firewall. For more information on the communication ports used by GFI 
EventsManager refer: http://kbase.gfi.com/showarticle.asp?id=KBID002770. 

2. That GFI EventsManager has administrative privileges over the computers that are 
running on the DMZ. 

http://kbase.gfi.com/showarticle.asp?id=KBID002770
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2.1.2 Deployment of GFI EventsManager on a demilitarized 
zone 

 
Figure 5 - The DMZ sits between the internal LAN and the Internet 

GFI EventsManager can also be deployed on a Demilitarized Zone (DMZ). This is the 
neutral network which sits between the “internal” corporate network and the “outside 
world” (i.e. the internet). The deployment of GFI EventsManager on a DMZ helps you 
automate the management of events generated by DMZ hardware and software 
systems. 

Automate management of Web and Mail server events 

DMZ networks are normally used for the running of hardware and software systems 
that have internet specific roles such as HTTP servers, FTP servers, and Mail 
servers. 

Hence, you can deploy GFI EventsManager to automatically manage the events 
generated by: 

 Linux/Unix based web-servers including the W3C web-logs generated by Apache 
web-servers on LAMP web platforms. 

 Windows based web-servers including the W3C web-logs generated by Microsoft 
Internet Information Servers (IIS). 

 Linux/Unix and Windows based mail-servers including the Syslog auditing 
services messages generated by Sun Solaris v. 9 or later. 

Automate management of DNS server events 

If you have a public DNS server, there‟s a good chance that you are running a DNS 
server on the DMZ. Hence you can use GFI EventsManager to automatically collect 
and process DNS server events including those stored in your Windows‟ DNS Server 
logs. 

Automate management of network appliance events 

Routers and firewalls are two network appliances commonly found in a DMZ. 
Specialized routers and firewalls (e.g. Cisco IOS series routers) not only help protect 

http://www.onlamp.com/pub/a/onlamp/2001/01/25/lamp.html
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your internal network, but provide specialized features such as Port Address 
Translation (PAT) that can augment the operational performance of your systems. 

By deploying GFI EventsManager on your DMZ, you can collect the events 
generated by such network appliances. For example, you can configure GFI 
EventsManager to act as a Syslog Server and collect in real-time the Syslog 
messages generated by Cisco IOS routers. 

2.2  Hardware requirements 

 Processor: 2.5 GHz or higher processor clock speed 

 RAM: 2048 MB 

 Hard disk: 10 GB of available space 

 

Hard disk size depends on your environment, the size specified in the 
requirements is the minimum required to install and archive events. 

2.3  Software requirements 

Software requirements - Installation machine(s) 

Supported Operating Systems 

 Windows Server 2008 - Standard or Enterprise (x86 or x64) 

 Windows Server 2008 R2 - Enterprise 

 Windows Server 2003 (SP2) - Standard or Enterprise (x86 or x64) 

 Windows 2000 (SP4) - Server or Advanced Server 

 Windows 7 - Enterprise, Professional or Ultimate (x86 or x64) 

 Windows Vista - Enterprise, Business or Ultimate (x86 or x64) 

 Windows XP - Professional (x86 or x64) 

 Windows SBS 2008 

 Windows SBS 2003 

Other components 

 .NET framework 2.0 Service Pack 2 or later. 

 Microsoft Data Access Components (MDAC) 2.8 or later 

 

Microsoft Data Access Components (MDAC) 2.8 can be downloaded from 
http://www.microsoft.com/Downloads/details.aspx?familyid=6C050FE3-
C795-4B7D-B037-185D0506396C&displaylang=en 

 (Optional) A mail server (If email alerting is configured) 

http://www.microsoft.com/Downloads/details.aspx?familyid=6C050FE3-C795-4B7D-B037-185D0506396C&displaylang=en
http://www.microsoft.com/Downloads/details.aspx?familyid=6C050FE3-C795-4B7D-B037-185D0506396C&displaylang=en
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 Microsoft SQL Server database or Microsoft SQL Express for events archiving 

 

Microsoft SQL server must have TCP port 1433 open to store events 
collected by GFI EventsManager. For more information, refer to 
http://support.microsoft.com/kb/287932 

Software requirements - Scanned machine(s) 

 For Microsoft Windows event log scanning: 

o Remote registry service must be enabled. 

 W3C log scanning: 

o The source folders must be accessible via Windows shares. 

 Syslog and SNMP Traps: 

o Sources/senders must be configured to send messages to the 
computer/IP address where GFI EventsManager is installed. 

2.4  Other requirements 

2.4.1 Ports and permissions that must be enabled 

Ports used by GFI EventsManager 

Table 1 below describes the ports  used by GFI EventsManager to process and 
collect events from target computers. 

Table 1 - Ports used by GFI EventsManager 

Port Protocol Description 

135 UDP and TCP Target machines use this port to publish information 
regarding available dynamic ports. GFI EventsManager 
uses this information to be able to communicate with 
the target machines.   

139 and 445 UDP and TCP Used by GFI EventsManager to retrieve the event log 
descriptions from target machines. 

162 UDP and TCP Used by GFI EventsManager to receive SNMP traps. 
Ensure that this port is open on the machine where GFI 
EventsManager is installed 

514 UDP and TCP Used by GFI EventsManager to receive SYSLOG 
messages. 

1433 UDP and TCP Used by GFI EventsManager to communicate with the 
SQL Server database backend. Ensure that this port is 
enabled on Microsoft SQL Server and on the machine 
where GFI EventsManager is installed. 

7787 and 7788 UDP and TCP RPC ports used by GFI EventsManager to handle the 
communications between the internal components of 
the product including the event processing engine and 
the user interface. Ensure that these ports are open on 
the machine where GFI EventsManager is installed. 

http://support.microsoft.com/kb/287932
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Firewall permissions that must be enabled 

When using Microsoft Windows firewall, ensure that all the firewall permissions and 
policies listed in Table 2 below, are enabled on all target machines.  

Table 2 - Firewall permissions to enable 

Firewall 
permissions 
and Audit 
policies 

Microsoft 
Windows 
Server 
2008  

Microsoft 
Windows 
Server 
2003  

Microsoft 
Windows 
XP 

Microsoft 
Windows 
Vista 

Microsoft 
Windows 
7 

Remote Event 
Log 
Management 

Enable 
Not 
applicable 

Not 
applicable 

Enable Enable 

File and Printer 
sharing 

Enable Enable Enable Enable Enable 

Network 
discovery 

Enable 
Not 
applicable 

Not 
applicable 

Enable Enable 

Audit policy: 
Object auditing 

Enable 
Not 
applicable 

Not 
applicable 

Enable Enable 

Audit policy: 
Process tracking 

Enable 
Not 
applicable 

Not 
applicable 

Enable Enable 

Audit policy: 
Audit account 
management 

Enable Enable Enable Enable Enable 

Audit policy: 
Audit system 
events 

Enable Enable Enable Enable Enable 

For more information how to set permissions refer to the following sections:  

 To apply settings manually on each target machine refer to Enabling permissions 
on target computers manually 

 To apply settings automatically on target computers using Microsoft Active 
Directory GPO, refer to Setting permissions on target computers automatically via 
GPO. 

2.4.2 Microsoft Windows Vista and Microsoft Windows 7 

Microsoft Windows Vista and Microsoft Windows 7 introduced extensive structural 
changes in event logging and event log management. The most important of these 
changes include: 

 A new XML-based format for event logs. This provides a more structured 
approach to reporting on all system occurrences. 

 Event categorization in four distinct groups: Administrative, Operational, Analytic 
and Debug 

 A new file format (evtx) that replaces the old evt file format. 

Due to these changes, to collect and process event logs from Microsoft Windows 
Vista or later, GFI EventsManager must be installed on a system running Microsoft 
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Windows Vista or later. (For example, GFI EventsManager cannot be installed on 
Microsoft Windows XP to monitor events on Microsoft Windows 7 machines). 

 

Windows XP events can be collected when GFI EventsManager is 
installed on Microsoft Windows Vista or later machines. 

 

When GFI EventsManager is using a non-domain account to collect 
events from Microsoft Vista machines or later, target machines must have 
User Account Control (UAC) disabled. For more information on how to 
disable UAC, refer to Disable UAC to scan target machines section in this 
manual. 

2.5  Upgrading from a previous version 

Upgrading from versions 7.x and 8.x to GFI EventsManager 2010 is fully supported. 
To upgrade to GFI EventsManager 2010, follow the installation procedures provided 
in the installation procedure section within this chapter of the manual. 

Upgrading from versions older than version 7 is not possible due to the underlying 
operational and processing technology subsystems which are different from the 
current version of GFI EventsManager. You will still however be able to run an older 
(pre-version 7) version of GFI EventsManager on the same machine on which a 
newer version of GFI EventsManager is installed since there are no conflicts between 
the older and the newer versions. 

2.6  Installation procedure 

GFI EventsManager includes an installation wizard which will assist you through the 
installation process. To start the installation: 

1. Close all running applications and log-on the target computer using an account 
which has local administrative privileges. 

2. Double-click on eventsmanager.exe. 

3. If GFI EventsManager detects that the basic dependencies are not present, a 
dialog will outline the missing dependency or dependencies and you will be allowed 
to install the missing dependencies manually or automatically. 

4. As soon as the welcome dialog is displayed, click Next to start the installation. 

5. Read the licensing agreement carefully. To continue installing the product, select 
the „I accept the Licensing agreement‟ option and click Next. 

6. If an installation of Microsoft SQL Server is not detected on the local machine, the 
SQL Server Express install is launched automatically. Select one of the following 
options: 

 Download and install Microsoft SQL 2005 Express Edition 

 Use a remote instance of Microsoft SQL Server. 

Click Next. 
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Screenshot 2 - Customer and License detail screen 

7. Specify your name and license key. If you are evaluating the product, leave the 
license key as default (i.e. „Evaluation‟) and click Next. 

 
Screenshot 3 - Logon information screen 
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8. GFI EventsManager must run under an account which has domain administrative 
privileges. Enter the user name and password of domain administrator account and 
click Next to continue. 

9. Specify an alternative installation path or click on Install to leave as default and 
proceed with the installation. 

10. Click Finish to finalize the installation. 
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3 Getting Started 

3.1  Introduction 

What is a computer log? 

A computer log is a collection of events entries. These entries provide an audit trail of 
information related to the activity of a network or computer system. In fact, computer 
logs are recorded in a certain scope to provide information suitable for forensic 
analysis. The computer log may be a binary file as in the case of Windows logs, or 
text-based files as in the case of Syslog or W3C logs. 

What is a log? 

An event is a log entry that provides information on something that occurred within a 
computer system or network. Such events include various details such as the date 
and time the event occurred and a related description. Event entries are often stored 
in chronological order to facilitate event browsing and forensic analysis. 

What are Windows Event Logs? 

Windows Event Logs are a systematic recording of computer related events that 
occurred within computer systems and networks running on Windows Operating 
Systems. In systems running on Windows 2000/XP/2003/VISTA, events are recorded 
and organized in 3 default event logs: 

 Application log 

 Security log 

 System log. 

Computers with specialized network roles such as domain controllers and DNS 
servers allow the logging of events to additional (default) logs such as: 

 Directory service log 

 File Replication service log 

 DNS server log. 

Windows Event Logs contain the following types of events: 

 Error - Error events indicate that a significant problem, such as loss of data or 
functionality has occurred. For example an Error event is recorded every time that a 
service or driver fails to load during startup. 

 Warning - Warnings indicate events that are not necessarily significant, but which 
may possibly cause future problems. For example, a Warning event is recorded 
every time that disk space runs low. 
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 Information - Information events describe the successful operation of an 
application, driver, or service. For example, an Information event is recorded every 
time that a network driver loads successfully. 

 Success Audit - Success audit events indicate security access attempts that 
were successful. For example, a Success Audit event is recorded every time that a 
user successfully logs on to his Windows based workstation. 

 Failure Audit - Failure audit events indicate security access attempts that failed. 
For example, a Failure audit event is recorded every time that a user fails to access a 
network drive. 

A sample of the information typically recorded in a Windows Event Log is shown 
below. 

 
Screenshot 4 - Windows event log 

What are W3C logs? 

W3C logs are used mainly by web servers to log web related events including web 
logs. W3C logs are recorded in text-based flat files using any one of the two W3C 
logging formats currently available: 

 W3C Common Log file format 

 W3C Extended Log File format. 
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The W3C common log file format was the first format to be released and to date it is 
still the default format used by a variety of popular web servers including Apache. 
There is however one downside - the information about each server transaction is 
fixed and does not provide for certain important fields such as referrer, agent, 
transfer time, domain name, or cookie information. To overcome this problem, the 
W3C Extended log file format was released. This newer type of log is in customizable 
ASCII text-based format, permitting a wider range of data to be captured. The W3C 
Extended log file format is the default log file format used by Microsoft Internet 
Information Server (IIS). 

A sample of the information typically recorded in a W3C extended type log is shown 
below. 

#Version: 1.0 

#Date: 04-Sep-2009 00:00:00 

#Fields: time cs-method cs-uri 

00:34:23 GET /WebSRV/Pg_Snippet.html 

12:21:16 GET /WebSRV/ Button_pg.html 

12:45:52 GET /WebSRV/ Login_Pg.html 

12:57:34 GET /WebSRV/ Error_msg.html 

What are Syslogs? 

Syslog is the standard for logging messages, such as system events, in an IP 
network. The Syslog standard is most commonly used for the logging of events by 
computer systems running on UNIX and Linux as well by network devices and 
appliances such as Cisco routers and the Cisco PIX firewall. Syslog events are not 
directly recorded by applications running on the computer systems. Whenever an 
event is generated, the respective computer will send a small textual message 
(known as Syslog message) to a dedicated server commonly known as „Syslog 
server‟. The Syslog server will then save the received message into a log file. Syslog 
messages are generally sent as clear text; however, an SSL wrapper can be used to 
provide for a layer of encryption. 

Syslog is typically used for computer system management and security auditing. 
While it has a number of shortcomings, its big plus is that Syslog is supported by a 
wide variety of devices and receivers. Because of this, Syslog can be used to 
integrate log data from many different types of systems into a central repository using 
the Syslog server as a log aggregator. 

The Syslog daemon handles the recording of Syslog messages/events in log files. 
The Syslog message is composed of two main parts: 

1. The „header‟ which contains date/time information as well as the IP or computer 
name from where the message has originated. 

2. The “message” which includes the program or subsystem name and the message 
itself, separated by a colon. 
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The following is an example of a Syslog message: 

Sep 4 10:10:10 10.245.2.11 foo[421]: this is a message from 

WebSRV 

What are SNMP Traps? 

SNMP Traps are used by network management systems to monitor network devices 
(such as routers, firewalls or switches) for conditions that require administrative 
attention. This includes monitoring device uptime, inventories of operating system 
versions and collecting interface information. SNMP enabled devices do not record 
event messages locally but instead these transmit event details to an SNMP Trap 
server which analyzes these occurrences and alert systems administrators on key 
events. 

GFI EventsManager includes its own SNMP Trap server that captures SNMP 
messages and informs systems administrators of network device failures and other 
critical events. GFI EventsManager supports various versions of SNMP Traps 
including SNMP versions 1, 2 and 3 (the encoded version). 

What are SQL Server audit logs? 

Microsoft SQL Server generates event logs that allow the network administrator to 
monitor database activity. GFI EventsManager allows you to process the activity logs 
generated by day-to-day SQL Server operations such as server startup or on key 
events such as failed logons. Alerts can also be created when key events such as 
consecutive login failure is identified in Microsoft SQL Server audit logs. 
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3.2  Getting started: Running GFI EventsManager for the first time 

After installation, the GFI EventsManager console is launched automatically. To 
launch GFI EventsManager click Start ► All Programs ► GFI EventsManager ► 
Management Console. 

Follow the steps outlined below to configure GFI EventsManager for first time use: 

 

Figure 6: Running GFI EventsManager for the first time 

3.3  Step 1: Configure the database backend 

Set up the database backend on first launch of GFI EventsManager. 

 

If you opted to install Microsoft SQL Server during the GFI EventsManager 
installation, the database backend required by GFI EventsManager will be 
set up automatically. You are therefore not required to manually create the 
database backend. 

 
Screenshot 5 - Database backend alert displayed on Quick Start Dialog 

An alert will appear at the bottom of the Quick Start Dialog indicating that you are 
required to configure a Microsoft SQL Server database backend. Click on Click 
here… in the alert box to configure the Microsoft SQL backend database. 
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Screenshot 6 - Database Options - Change database tab 

To configure the SQL Server and database backend details: 

1. Specify the name/IP of your SQL Server. 

2. Key in a name for your database backend (e.g. EventsManager). 

3. Select the authentication method used to connect to the SQL Server. If SQL 
Server authentication is selected, specify the login username and password. 

4. (Optional) Click Validate database to check that the selected database exists and 
has the correct structure.  

5. Click Advanced settings tab to select the language character and symbol support 
to be used. 

6. Click OK to finalize settings. 

 

Microsoft SQL server must have TCP port 1433 open to store events 
collected by GFI EventsManager. For more information, refer to 
http://support.microsoft.com/kb/287932 

http://support.microsoft.com/kb/287932
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The account under which GFI EventsManager is running, requires read and write 
access privilege on the database. To enable these privileges: 

1. Launch SQL Server Management Studio and from the Object Explorer, expand 
Security ► Logins. Check that the account to be used by GFI EventsManager is 
listed in the Logins folder. 

 

If you are using Microsoft SQL Express, download the Microsoft SQL 
Server Management Studio Express from: 

http://www.microsoft.com/downloads/details.aspx?familyid=C243A5AE-
4BD1-4E3D-94B8-5A0F62BF7796&displaylang=en 

 
Screenshot 7 – SQL Server Management – Logins folder 

2. Right click the user and select Properties. 

http://www.microsoft.com/downloads/details.aspx?familyid=C243A5AE-4BD1-4E3D-94B8-5A0F62BF7796&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=C243A5AE-4BD1-4E3D-94B8-5A0F62BF7796&displaylang=en


 

28  Getting Started GFI EventsManager manual 

3. From the left  panel, select Server Roles page and check that sysadmin is 
selected. 

 
Screenshot 8 – SQL Server Management – Login Properties dialog  

4. Click OK and close the SQL Server Management Studio. 
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3.4  Step 2: Launch events processing 

You are now required to define the event sources i.e. the computers from which 
events will be collected. 

 
Screenshot 9 - Quick Start Dialog 

From the Quick Start dialog three different types options can be selected: 

1. Process events - local computer: This option defines the local computer as the 
events source machine. This option is highly recommended for first time users who 
want to gather events on the machine where GFI EventsManager is installed. 

2. Process events - selected machines: This option defines a specific range of 
networked machines as the events sources. This option is recommended for first 
time users who want to gather information on a wide range of networked computers. 

3. Customize: This advanced option enables you to customize different types of 
events or different types of sources (e.g. Syslog and SNMP Trap processing) and is 
recommended for administrators. 

3.4.1 Processing events from the local computer 

To process event logs from the local machine: 

1. From the Quick Start Dialog, click Process events - local computer. GFI 
EventsManager will start to collect events from the local machine immediately. 
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Screenshot 10 - Events processed from local machine 

On completion, the number of events that have been processed is displayed in the 
information bar as illustrated in the screenshot above. 



 

GFI EventsManager manual Getting Started  31 

3.4.2 Processing events from selected machines 

 
Screenshot 11 - Process events from selected machines 

To collect event logs from selected machines: 

1. From the Quick Start Dialog, click Process events - selected machines to launch 
the Add New Event Sources wizard. 

2. Specify the name/IP of the new event source and click Add. Repeat until you have 
specified all the event sources to add to this group. 

 

To import the list of event sources from a text file click Import button. To 
select event sources from a list, click Select button. 

3. Click Finish to finalize settings. GFI EventsManager will collect events from the 
configured sources immediately after clicking Finish. 

3.5  Step 3: Analyze events and generate reports 

3.5.1 Navigating the Quick Launch Console 

You can now analyze the event information collected and generate reports based on 
the data gathered. 
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Screenshot 12 - GFI EventsManager Quick Launch Console 

The Quick Launch Console provides the common next steps that should be 
undertaken after processing events.. Closing the Quick Launch Console minimizes it 
to the user interface. To restore the Quick Launch console, click on the Open Quick 

Launch Console link  from the top right-hand corner of the 
GFI EventsManager user interface. Table 3 below describes the options available in 
the Quick Launch Console. 

Table 3 - Quick Launch Console options 

Icon Description 

 

Browse events 

Access the built-in events and forensic tools that will help you to locate, analyze and 
filter key events. Clicking Browse events, opens the Windows Events Browser 
window in the Events Browser. For more information refer to Event browsing chapter 
in this manual. 

 

Generate reports 

Access reporting features including instant/scheduled report generations and 
automated report distribution. Clicking Generate Reports, opens the Reporting tab. 
For more information refer to Generating reports chapter in this manual.  

 

Manage event sources 

Specify additional sources from where events are collected and processed. Click 
Manage event sources, to open the Add New Event Sources dialog. 
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Icon Description 

 

Customize 

Customize GFI EventsManager settings, such as enabling Syslog, SNMP Trap 
processing, key events notifications, etc. Clicking on Customize opens the Quick Start 

Dialog: Customization Options dialog. For more information refer to Customizing event 
sources chapter in this manual. 
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4 Event browsing 

4.1  Introduction 

The Event Browsing option allows you to access and browse processed or 
unprocessed events/logs that are currently stored in the main or backup database. 

 
Screenshot 13 - GFI EventsManager: Events Browser 

Use the Events Browser for forensic analysis of events. All events accessible 
through the Events Browser are organized (by log type) in the following tabs:  

 Windows Events Browser 

 W3C Events Browser 

 Syslog Events Browser  

 SNMP Traps Events Browser 

 Microsoft SQL Server Audit Browser  

This way you can quickly access the events belonging to a particular log type. Event 
data is organized into columns and clicking on a particular event will show additional 
information in a dedicated events description pane. The header color coding enables 
you to quickly identify the severity of the event. 
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Screenshot 14 - Event details provided in the Events Browser 

Windows events, descriptions are organized in two tabs accessible from the events 
description field: 

 General tab - Contains events information in the legacy format that was standard 
for pre-Microsoft Windows Vista event logs. 

 XML Data tab - Contains events information in the new XML based Microsoft 
Windows Vista format. 
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Use the link provided in the event description pane to access: 

 A more detailed description of the event 

 Information and links that explain what causes this type of event 

 Hints and tips on how to possibly solve any existing issues. 

The navigation tool bar allows you to navigate between pages, stop a query and 
configure the auto-refresh rate. To configure auto-refresh, click the refresh icon and 
select the required time interval.  

  
Screenshot 15 – Configure auto-refresh 

4.2  Event browsing tools 

Event analysis is quite a demanding task; GFI EventsManager is equipped with 
specialized tools that simplify the search for specific events as well as enable the 
export of events to CSV files. These specialized tools include: 

 An event filter/query builder 

 Event color-coding options 

 Event finder tool 

 Export events tool 

4.2.1 Event filter/query builder 

Use the event query builder to create custom filters that sift events data and display 
only the information needed. For more information on how to create a custom query, 
refer to Creating custom event queries in this chapter. 
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Screenshot 16 – Create new query using the query builder 

GFI EventsManager ships with pre-configured queries that can filter events without 
any configuration effort. For more information on how to use pre-configured queries, 
refer to Applying event queries in this chapter 
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Screenshot 17 - Default and custom event queries 

4.2.2 Event color-coding options 

Use the event color-coding tool to tint key events in a particular color. This way the 
required events are easier to locate during event browsing. For example, you can 
create a query that shows events classified as Critical or High and at the same time 
color in red all Critical events having event ID 231. 

 
Screenshot 18 – Color coding configuration 

The configuration of color-codes is carried out through a dedicated query builder. To 
use the query builder click Advanced and configure the following options: 

 The conditions that define which events must be colored 

 The colors to be used when showing these events. 

For more information on how to configure color-coding options, refer to Configuring 
event color coding in this chapter. 
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4.2.3 Event finder tool 

 
Screenshot 19 - Event finder tool 

Use the event finder tool to locate events that match a specific search string. For 
example, you can search events that have a specific ID or which contain specific 
keywords in the description. For more information on the event finder tool, refer to 
Event finder tool in this chapter. 

4.2.4 Export events tool 

 
Screenshot 20 - Export events tool 

Use the export events tool to save events data to CSV file. For more information refer 
to Export events tool in this chapter. 

4.3  Accessing and browsing stored event logs 

 

Screenshot 21 - Events browsers 

To access and browse events stored in the database backend click on the Events 
Browser tab and select a browser accordingly. 
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4.4  Applying event queries 

To filter event during browsing: 

1. Click on the Events Browser tab and select the event browser required. 

2. From the left pane select the required events filter (such as the Accounts Usage 
filter). Results will be displayed in the browser (right pane). 

 

Screenshot 22 - Selecting a filter 

4.5  Creating custom event queries 

In GFI EventsManager, custom queries are added as a sub-node within the default 
queries that ship with the product. To create custom event queries: 

1. Click on the Events Browser tab and select one of the following tabs: 

 Windows Events Browser 

 W3C Events Browser 

 Syslog Events Browser 

 SNMP Traps Events Browser 

 Microsoft SQL Server Audit Browser 
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Screenshot 23 - GFI EventsManager: Events Browser 

2. Right-click on the default query where the new event query will be created and 
select Create query… This will bring up the event query builder. 
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Screenshot 24- Custom query builder 

3. Specify a name and a description for the new query. 

4. Click Add, configure the required query condition(s) and click OK. Repeat until all 
required query conditions have been specified. For more information on field 
operators refer to Field operator section in this manual. 

5. Click OK to finalize your settings. 

4.6  Create query from an existing event 

GFI EventsManager allows the administrator to sort events automatically by creating 
custom queries. Each query has its own filtering criteria, and administrators can 
create a query by selecting a particular field from an existing event. The selected field 
will automatically be included in the filtering criteria. To automatically create a query 
based on a field: 

1. Click Events Browser tab. 

2. From the Queries list, select the type of query and the existing event. 
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3. Right click the field that will be included in the query builder, and click Create 
query from field.  

4.6.1 View or Edit a custom query 

The naming convention of the new query is Type equal <Field Selected>. To edit 
the query, right click the query and select Properties. 

 
Screenshot 25 – Query builder for an existing query 

4.7  Customizing the event viewer pane 

Select columns to be displayed 

To select which columns will be displayed in the Log Browser‟s viewing pane: 

1. Click on the Events Browser tab and select an events browser accordingly. 

2. Select the Customize view option from the „Common Tasks‟ area in the left pane. 
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Screenshot 26 - Customize view: columns 

3. Select the Columns option. 

4. Select the columns that will be displayed in the viewing pane. Use the up/down 
arrows on the side to define the order in which the columns will be shown. 

5. Close the customize view pane to finalize your settings. 

Customize the position of the description window 

GFI EventsManager allows you to customize the right viewing pane. To achieve this: 

1. Click on the Events Browser tab and select an events browser accordingly. 

 
Screenshot 27 - Customize view 

2. Click the Customize view option from the „Common Tasks‟ pane. 
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3. Customize the browser view accordingly. 

4.8  Configuring event color coding 

Assigning a color-code to a specific event 

 
Screenshot 28 - Assigning event color-codes 

To assign a color code to a specific event: 

1. Click on the Events Browser tab and select an events browser accordingly. 

2. Select the Customize view option and from the right pane, select the Colors 
option. 

3. Specify event filter parameters including the color to be applied to the sifted 
events. 

4. Click on the Apply Color button to finalize your settings. 

 

Use the Clear color filters option to clear all color settings. 

Assigning different color-codes to multiple events 

To assign different color-codes to multiple events: 

1. Click on the Events Browser tab and select an events browser accordingly. 

2. Select the Customize view option. From the right pane, select the Colors option 
and click Advanced. 
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Screenshot 29 - Advanced Color Filter  

3. Click on the Add button. Specify filter name and configure event filter parameters. 

4. Click on the OK button to save filter settings. 

5. Repeat until all required event filter conditions have been configured. Click OK to 
finalize your settings. 
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4.9  Event finder tool 

Use the event finder tool to search and locate specific events using simple 
customizable filters. To search for a particular event: 

1. Click on the Events Browser tab and select an events browser accordingly 

2. From the left pane, select the Find events option. 

 
Screenshot 30 - Event finder tool 

3. Configure the event search parameters through the options provided on top of the 
right pane. To trigger a case sensitive search, click on Options and select the Match 
case option. 

4. Click on the Find button to trigger the search. 

4.10  Export events tool 

GFI EventsManager allows you to export events data to CSV files directly from the 
built-in event-browsers. This is extremely convenient especially when further 
processing of events data is required including: 

 Distribution of key events data via email 

 Running automated scripts which convert CSV exported events data to HTML for 
upload on web/company intranet 

 Generation of graphical management reports and statistical data using native 
tools like Microsoft Excel 

 Generation of custom reports using third party applications. 

 Interfacing events data with applications and scripts built in-house 

To export events to CSV: 

1. Click Events Browser tab and select the required event browser accordingly. 

2. Select the events to be exported. Right-click on the selection and choose Export 
events…. 



 

GFI EventsManager manual Event browsing  49 

 
Screenshot 31 - Export events tool 

3. Specify the location where exported events will be saved and click OK to trigger 
the export operation. 

4.11  Backup events 

GFI EventsManager allows you to backup the events stored in the main database 
backend. This way you can reduce the size of your main database backend but at 
the same time keep all your event records for historical and forensic investigation 
purposes. 

Use the backup events feature to backup events that are older than a specific 
amount of hours. For example, you can choose to backup events that are older than 
48 hours. To backup events: 

1. Click on the Events Browser tab and select an events browser accordingly. 

2. From the left pane, select the Backup events option. 

 
Screenshot 32 - Backup events dialog box 

3. Specify backup parameters and click on the OK button to finalize your settings. 
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4.12  Switching databases 

For event browsing purposes, GFI EventsManager allows you to switch between 
different databases. Use this feature to browse events that have been backed up, 
using the tools provided in the Events Browser. To achieve this: 

1. Click on the Events Browser tab and select an events browser accordingly. 

2. From the left pane select the Switch to main/backup database option. 

 
Screenshot 33 – Add a new database from the switch database dialog 
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3. Double click the destination database (were the events will be stored), or click Add 
to create a new database. 

4.13  Clear events 

4.13.1 Clear events from a query result 

To clear a group of events from the currently selected database: 

1. Click on the Events Browser tab and select an event browser accordingly. 

2. From the left pane, select the query that will be cleared. 

3. Select the Clear all events option. 

 
Screenshot 34 - Clear all events dialog box 

4. Select between: 

 Backup events before clearing – Selected events will be stored in the backup 
database. 

 Clear only (no backup) – Selected events will be removed from the Event 
Browser and deleted from the database. 

5. Click OK. 

 

To clear all events from the database, create a new database operation to 
delete the data. For more information on how to create a delete operation, 
refer to Delete data section in this manual.  
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5 Generating reports 

5.1  Introduction 

GFI EventsManager provides you with a free, fully-fledged reporting companion to 
GFI EventsManager - GFI EventsManager ReportPack. It enables you to generate 
graphical IT-level, technical and management reports based on the hardware and 
software events processed by GFI EventsManager. Hardware and software event 
sources include any networked component that generate Syslog messages or 
record/log events to Windows and/or W3C event logs. These include computers, 
network devices, PABXs, and third party software solutions. 

To access GFI EventsManager ReportPack, click the Reporting tab. 

To generate reports, the following add-ins must be downloaded and installed: 

 GFI ReportCenter framework 

 GFI EventsManager ReportPack 

More information on how to download the GFI EventsManager ReportPack and the 
GFI ReportCenter framework is provided in the Download the GFI EventsManager 
ReportPack section in this chapter. 
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5.2  Download the GFI EventsManager ReportPack 

From the GFI EventsManager Reporting tab, click on Install ReportPack button to 
download and install the GFI EventsManager ReportPack on the local machine. Prior 
to installing the GFI EventsManager ReportPack, GFI EventsManager will also 
prompt you to install any pre-requisites that are required. This includes the GFI 
ReportCenter framework. 

 

Screenshot 35 – Downloading GFI EventsManager ReportPack 

For installation instructions and more information about the GFI EventsManager 
ReportPack refer to GFI EventsManager ReportPack manual, available at: 
http://www.gfi.com/eventsmanager/esm2010rpmanual.pdf. 

http://www.gfi.com/eventsmanager/esm2010rpmanual.pdf
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5.3  Launching the GFI EventsManager ReportPack 

 

Screenshot 36 - Launching the GFI EventsManager ReportPack 

To generate reports: 

1. Click on the Launch ReportPack button 

 

Screenshot 37 - GFI EventsManager ReportPack console 
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2. The GFI EventsManager ReportPack console will open in a new window. 
Generate the required reports by right clicking on the desired report. 

For more information about the reports and the functionalities of GFI EventsManager 
ReportPack refer to GFI EventsManager ReportPack manual, available at: 
http://www.gfi.com/eventsmanager/esm2010rpmanual.pdf. 

 

http://www.gfi.com/eventsmanager/esm2010rpmanual.pdf
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6 Customizing event sources 

6.1  Introduction 

Event sources are computers that contain the logs to be processed by GFI 
EventsManager. In GFI EventsManager, these event sources are organized into 
specific computer groups. You can create custom event source groups tailored on 
your network infrastructure or you can use the pre-defined groups that ship by default 
with this product. GFI EventsManager ships with two distinct event source groups 
namely Event Sources Groups and Database Server Groups. You can use default 
groups to distinctively organize and configure the servers, workstations and laptops 
that will be monitored by GFI EventsManager; or you can choose to group target 
computers that have specific roles on your network such as web Servers, file servers 
and data servers. 

6.2  Adding new event sources to the computers group 

 
Screenshot 38 - Configuring the computer that will be monitored 
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To add new event sources to a computer group: 

1. Click on the Configuration tab and select Event Sources from the tab options. 

2. From the Group Type drop-down, select Event Sources Groups. 

3. Right-click on the Computer Group which will contain the new event sources and 
select Add new event source. Admin 

 
Screenshot 39 - Configuration wizard: Specify the computers that will be monitored 

4. Specify the name/IP of the new event source and click Add. Repeat until you have 
specified all the event sources to add to this group. 

 

Since Syslog and SNMP traps use the IP address to determine the source 
of an event, it is recommended to use the source IP instead of the domain 
name when retrieving Syslog and SNMP traps from target machines. 

5. (Optional) Click Select to browse the network for existing domains and computers. 
Select the domain from the Domain drop down list and select the computers to add. 
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Screenshot 40 – Browse the network for connected computers 

 

To import the list of event sources from a text file click on the Import 
button. 

6. Click Finish to finalize your settings. GFI EventsManager will attempt to collect 
logs from the configured sources immediately after clicking the Finish button. 

6.3  Configuring event source properties 

GFI EventsManager allows you to customize the event source parameters to suit the 
operational requirements of your infrastructure. You can configure these parameters 
on a: 

 Computer by computer basis. 

 Group by group basis. 

Event source properties that can be customized include: 

 General event source properties such as computer group name 

 Alternative domain administrator credentials required to remotely access the 
event logs of a target computer. 

 Event source operational time. Through these parameters GFI EventsManager 
can identify key events that occur outside normal operational time such as failed 
logons. As a result alerts and notifications can be generated and dispatched to 
administrators for immediate attention. 

 Windows, W3C , SNMP and Syslog event processing parameters. 

To configure event source properties: 
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1. Click on the Configuration tab. 

 

Screenshot 41 - Group type 

2. From the Group Type drop-down select Event Sources Groups. 

3. To configure the parameters of a: 

 Computer group: Right-click on the computer group to be configured and select 
Properties. 

 Particular computer in a group: 

o Click on the computer / database server group to which the computer 
group belongs. 

o From the right pane, right-click on the required computer and select 
Properties. 

4. Click on the required tabs and configure the respective parameters accordingly. 
More information on how to configure these parameters is provided in this chapter. 
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6.3.1 Configuring general event source properties 

 
Screenshot 42 - Event sources properties dialog 

Use the General tab in the properties dialog to: 

 Change the name of a computer group. 

 Enable/disable log collection and processing for the computers in a group. 

 Configure log collection and processing frequency. 

6.3.2 Configuring alternative domain administrator credentials 

During event processing, GFI EventsManager must remotely log-on to the target 
computers. This is required in order to collect log data that is currently stored on the 
target computers and to pass this data on to the event processing engine(s). 

To collect and process logs, GFI EventsManager must have administrative privileges 
over the target computers. By default, GFI EventsManager will log-on to target 
computers using the credentials of the account under which it is currently running; 
however, certain network environments are configured to use different credentials to 
log on to workstations and servers with administrative privileges. As an example for 
security purposes, network administrators can setup a dedicated account that has 
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administrative privileges over workstations only and a different account that has 
administrative privileges over servers only. 

 
Screenshot 43 - Configuring alternative logon credentials 

GFI EventsManager, allows you to configure a dedicated set of logon credentials for 
individual target computers as well as for computer groups. To configure a set of 
credentials for a particular computer group: 

1. Right click on an event source and click on Properties 

2. Click on the Logon Credentials tab 

3. Specify the login name and password which will be used to log-on and collect logs 
from the target computer(s). 

6.3.3 Configuring event source operational time 

GFI EventsManager includes an Operational Time option through which you specify 
the normal working hours of your event sources. This is required so that GFI 
EventsManager can keep track of the events that occur both during and outside 
working hours. Use the operational time information for forensic analysis and to 
identify network computers that are being misused outside normal working hours. For 
example, through this information, you can discover unauthorized user access, illicit 
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transactions carried out outside normal working hours and other potential security 
breaches that might be taking place on your network. 

 
Screenshot 44 - Specify operational time 

Operational time is configurable on computer group basis. Configuration is achieved 
through the Operational Time tab provided in the computer group properties; 
Operational time is configured by marking the normal working hours on a graphical 
operational time scale which is divided into 1 hour segments. 

6.3.4 Synchronize computer list to a text file 

The list of computers in a group can be synchronized with a text file. The text file 
must contain the computer domain names or IP addresses. GFI EventsManager 
monitors changes in the text file and add or remove computer nodes accordingly. To 
configure text file synchronization: 

1. Select Configuration tab. 

2. From the Groups list, right click the group to be configured and select Properties. 

3. Click Sync tab and use the Browse button to locate the text file. 

4. From the Sync type drop down list, select the type of synchronization. Select: 
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 Do not sync - Disable synchronization, computers added or removed from the 
text file are not updated in GFI EventsManager. 

 Add new computers - Computers added in the text file are added automatically 
in GFI EventsManager group. Computers removed from the text file will not be 
removed from GFI EventsManager. 

 Delete removed computers - Computers removed from the text file are removed 
automatically from GFI EventsManager group. Computers added in the text file 
will not be added in GFI EventsManager group. 

 Full sync - If a computer is added or removed from the text file, GFI 
EventsManager will update the group accordingly. 

5. Click OK to save changes and exit. 

6.3.5 Configuring event processing parameters 

To configure event processing parameters: 

 
Screenshot 45 - Event-processing configuration tabs 

1. Select the Configuration tab. 

2. From the Groups list, right click the group to be configured and select Properties. 

3. Use the Windows Event Log tab, W3C Logs tab, Syslog tab and SNMP Traps 
to configure the required event processing parameters. For more information on why 
and how to configure these parameters refer to Using event processing rules 
chapter. 
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6.4  Adding a new SQL Servers group 

1. Click on the Configuration tab. 

2. From the Group Type drop-down select Database Servers Groups. 

 
Screenshot 46 - Creating a new SQL Server group 

3. Right-click on an existing group and select Create group. 

4. Configure the SQL Server group settings. For more information about SQL Server 
group configuration, refer to Configuring event source properties in this chapter. 

6.5  Configuring SQL Servers event source properties 

Similar to group properties both in concept as well as in terms of configuration, SQL 
Servers event source properties can be configured at both group level and individual 
SQL Server level. 

To configure the properties of an individual SQL Server or server group 

1. Click on the Configuration tab. 
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Screenshot 47 - Database Servers Groups 

2. From the Group Type drop-down select Database Server Groups. 

3. To configure the parameters of a: 

 Database Server Group: Right-click on the database server/ group to be 
configured and select Properties. 

 Particular computer in a database server group: Click on the database server 
group to which the computer group belongs. Then from the right pane, right-click 
on the required computer and select Properties. 

4. Use the tabs provided in the properties dialog, to configure the required 
parameters: 

 General properties: Use this tab to change the group name. 

 Logon credentials: Use this tab to select the authentication method to be used 
and if required specify login credentials. 

 Operational time: Use this tab to specify the operational time for the database 
servers specified in this group. 

 SQL Server audit: Use this tab to configure which event processing rules will be 
applied against the events collected from source. By default, GFI EventsManager 
is set to inherit these parameters from the parent Database Server Group. 

 Settings: Use this tab to configure SQL Server event-scanning options (i.e. scan 
all databases, scan security events only on all databases or scan only a specific 
database). 

 

For more information on how to configure these parameters please refer to 
Configuring database server properties section in this chapter 
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6.6  Adding new SQL Servers to the default group 

The SQL Server audit feature allows you to process the activity logs generated by 
day-to-day SQL Server operations such as server startup or on key events such as 
failed logons. 

Like computers, SQL Servers can be grouped and processed using a common 
event-log scanning policy. To create an SQL Server group: 

1. Click on the Configuration tab. 

 

Screenshot 48 - Database Servers Groups 

2. From the Group Type drop-down select Database Servers Groups. 

 

Screenshot 49 - Add a new Microsoft SQL Server 

3. In the Groups section, right click on SQL Servers and select Add new Microsoft 
SQL Server. 
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Screenshot 50 - Select Microsoft SQL Server(s) 

4. Click on the Select button and choose the required Microsoft SQL Server 
machines from list. Click OK when selection is complete. 

5. Click on the Finish button to finalize your settings. 

 

It is recommended not to perform SQL auditing on the same server being 
used by GFI EventsManager as its database backend. For more 
information refer to http://kbase.gfi.com/showarticle.asp?id=KBID003782. 

http://kbase.gfi.com/showarticle.asp?id=KBID003782
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6.7  Removing SQL Servers from the default group 

To remove a Database Server Group: 

1. Click on the Configuration tab. 

2. From the Group Type drop-down select Database Servers Groups. 

 

Screenshot 51 - Select Microsoft SQL Server to delete 

3. In the right pane, right click on the SQL Server to be deleted and select Delete. 

4. Click Yes to confirm delete. 
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6.8  Configuring database server properties 

By default, an SQL Server will inherit the properties that were set for the parent group 
settings. To change an SQL server settings: 

1. Click on the Configuration tab. 

 

Screenshot 52 - ‘SQL Servers’ Group 

2. From the Group Type drop-down select Database Servers Groups. 

3. From the Groups area, select the group that contains the SQL Server that you 
would like to edit, for example „SQL Servers‟. 

 

Screenshot 53 - Microsoft SQL Server group properties 

4. In the left pane, right click on the Microsoft SQL Server to be configured and select 
Properties. 
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Screenshot 54 - The SQL Server Group properties dialog 

5. Use the tabs provided in this dialog as follows: 

 General tab: Use this tab to set post collection processing rules. By default, GFI 
EventsManager will inherit post collection processing from the parent group. 

 Logon credentials: Use this tab to select the authentication method to be used 
and to specify login credentials if „SQL Server Authentication‟ will be used. 

 Settings: Use this tab to configure SQL Server event-scanning options (i.e. scan 
all databases, scan security events only on all databases or scan only a specific 
database). 

 

For more information on how to configure these parameters please refer to 
Configuring database server properties section in this chapter. 
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7 Using event processing rules 

7.1  Introduction 

GFI EventsManager allows you to collect and process: Windows Event Logs, W3C 
logs, Syslogs, SNMP Traps and Microsoft SQL Server audit logs. All supported log 
types record events in a different and proprietary format; therefore every log type 
requires different configuration settings and parameters. You can configure log 
collection and processing parameters: 

 On a computer by computer basis 

 On a computer group by computer group basis. 

During event processing, GFI EventsManager runs a configurable set of rules against 
the collected logs in order to classify events and trigger alerts/actions accordingly. By 
default, GFI EventsManager ships with a pre-configured set of event processing rules 
that allow you to gain network-wide control over computer logs - with negligible 
configuration effort. 

Event processing rules 

Event processing rules are instructions/checks that: 

 Analyze the collected logs. 

 Classify the severity of processed events. Classification is based on the 
configuration settings of the processing rule. 

 Filter events that match specific criteria. For example, you can create and run a 
rule which filters out low severity events and noise (duplicate events). 

 Generate alerts and actions based on event severity. For example, you can 
configure GFI EventsManager to send both SMS and Email alerts whenever an 
event is classified as critical; but limit the product to send only email alerts when 
an event is classified as high in severity. For more information on how to 
configure alerts and actions refer to Configuring alerting options section in this 
manual. 

 Optionally archive filtered events. Event archiving is based on the severity of the 
event and on the configuration settings of the event processing rules. For 
example, you can configure GFI EventsManager to archive only events that are 
classified critical or high in severity and discard all the rest. 

In GFI EventsManager, event processing rules are organized into „Rule-sets‟; and 
every rule-set can contain one or more specialized rules which can be run against 
collected logs. 
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Screenshot 55 - Rule-sets folder and Rule-sets 

Rule-sets are further organized into Rule-sets Folders. This way you can group rule-
sets according to the functions and actions that the respective rules perform. By 
default, GFI EventsManager ships with pre-configured folders, rule-sets and event 
processing rules that can be further customized to suite your event processing 
requirements. 

Event classification 

GFI EventsManager classifies events in 5 categories: 

 Critical 

 High 

 Medium 

 Low 

 Noise (unwanted or repeated log entries). 

Event classification is based on the configuration of the rules that are executed 
against the collected logs. Events that don‟t satisfy any event classification conditions 
are tagged as unclassified and can be set to trigger the same alerts and actions 
available for classified events. 

Event processing, classification and actions flowchart 

The flowchart chart below illustrates the event processing stages performed by GFI 
EventsManager. 
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Screenshot 56 - Log processing, classification and actions flowchart 

7.2  Collecting and processing Windows events  

Overview 

Windows events are organized into specific log categories; by default computers 
running on Windows NT or higher record errors, warnings and information events in 3 
logs namely Security, Application and System logs. Computers that have more 
specialized roles on the network (e.g. Domain Controllers, DNS Servers, etc.) have 
additional event log categories. 
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Screenshot 57 - Computer group properties: Configuring logs to be processed 

As a minimum, Windows Operating Systems record events in the following logs: 

 Security events log: This log contains security related events through which you 
can audit successful or attempted security breaches. Typical events found in the 
Security Events log include valid and invalid logon attempts. 

 Application events log: This log contains events recorded by software 
applications/programs such as file errors. 

 System events log: This log contains events logged by Windows XP system 
components such as failures to load device drivers. 

 Directory service log: This log contains events generated by the Active 
Directory including successful or failed attempts to make to update the Active 
Directory database. 

 File Replication service log: This log contains events recorded by the Windows 
File Replication service. These including file replication failures and events that 
occur while domain controllers are being updated with information about sysvol. 

 DNS server log: This log contains events associated with the process of 
resolving DNS names to IP addresses. 

 Application and Services Logs: These logs contain events associated with 
Windows VISTA and the relative services/functionalities it offers. 
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Screenshot 58 - Computer group properties: Configuring Windows Event Logs parameters 

To configure Windows Event Log collection and processing parameters you must: 

 Select the events to be collected. 

 Specify whether the collected logs will be processed (filtered, etc.) or just 
archived without processing. 

 Select the event processing rule-sets/rules that will be run against the collected 
logs. 

 Select if the events will be stored in the storage folder. For more information on 
how to archive events in a storage folder, refer to Archiving events after 
processing in this chapter. 

Selecting the events to be collected 

To specify which Windows events will be collected by GFI EventsManager: 

1. Launch the (computer/computer group) properties dialog. 

2. Click on the Windows Event Log tab. 
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Screenshot 59 - Selecting the events to be collected 

3. Click on Add and select the check-box of the events that will be collected. 

 

GFI EventsManager supports custom event logs. For information on how 
to configure custom event logs please refer to Configuring custom event 
logs section in this chapter. 

4. (Optional) Select the option Clear collected events after completion to clear the 
collected events from event sources. 

 

Deleting Syslog messages without archiving may lead to legal 
compliance issues. 

Archiving Windows events 

For information on how to archive events refer to Archiving events section in this 
manual. 
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Selecting Windows event processing rules 

For information on how to select event processing rules refer to Selecting event 
processing rules section in this manual. 

7.3  Configuring custom event logs 

GFI EventsManager is configured to collect and process standard Windows Event 
Logs. However, GFI EventsManager can also be configured to manage events 
recorded in third party application logs such as anti-virus logs, software firewall logs 
and other security software. 

To configure custom events: 

1. Click the Configuration tab and select Options. 

2. From the left pane, right-click on the Custom Events Logs node and select Edit 
custom logs… 

 

Screenshot 60 - Custom event logs setup 

3. Click on the Add… button and specify the name of your custom event log. 
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Screenshot 61 - Custom event logs dialog 

4. Click OK to finalize your settings. 
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Screenshot 62 - List of custom events 

5. (Optional) Click Edit to rename the selected custom event, or click Remove to 
delete the selected custom event. 

7.4  Collecting and processing W3C logs 

W3C is another log format supported by GFI EventsManager. W3C logs are text-
based flat files containing various event details delimited by special characters. 

The W3C log format is mostly commonly used by hardware systems (e.g. servers 
and appliances) which have internet specific roles. Microsoft Internet Information 
Server (IIS) service and Apache web servers for example, can collect web related 
events (i.e. web logs) in the form of W3C formatted text files. 

In GFI EventsManager, the configuration process of W3C log parameters is identical 
to that performed for Windows event processing, with one exception. Unlike Windows 
Event Logs, there is no standard which dictates a specific or centralized folder 
location where W3C log files are stored on disk. Therefore, in order to collect W3C 
logs, you must specify the complete path to these text-based log files. 

Selecting the events to be collected and processed 

To specify which W3C logs will be collected by GFI EventsManager: 
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1. Click Configuration ► Event Sources 

2. Right click a group or a single computer and select Properties. 

3. In the Properties window select W3C Logs tab. 

 
Screenshot 63 - Computer group properties: Configuring W3C event processing parameters 

4. Click on Add and specify the log file name and location. Wildcards such as *.* are 
supported. 

 

Screenshot 64 – Add a new W3C folder path 



 

GFI EventsManager manual Using event processing rules  83 

5. (Optional) Select Clear collected events after completion option, to clear the 
collected events from event sources. 

6. (Optional) Select Archive all scanned events in folder storage option to archive 
events in the storage folder after applying the processing rules. For more information 
on how to configure the storage folder, refer to Configure storage folder section in 
this manual. 

 

Deleting SNMP messages without archiving may lead to legal 
compliance issues. 

Archiving W3C events 

For information on how to archive events refer to Archiving events section in this 
chapter. 

Selecting W3C event processing rules 

For information on how to select event processing rules refer to Selecting event 
processing rules section in this manual. 

7.5  Collecting and processing Syslogs 

Syslog is a data logging service that is most commonly used in Linux and UNIX 
based environments. The concept behind Syslogs is that the logging of events and 
information is entirely handled by a dedicated server called „Syslog Server‟. This 
means that unlike Windows and W3C log based environments, regular programs do 
not log any information. They just send events in the form of data messages 
(technically known as „Syslog Messages‟) to a Syslog server that will manage the 
message and save the data in a log file. 
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Screenshot 65 - Computer group properties: Syslog processing parameters 

In order to process Syslog messages, GFI EventsManager ships with a built-in 
Syslog Server. This Syslog server will automatically collect, in real-time, all Syslog 
messages/events sent by Syslog sources and pass them on to the event processing 
engine. Out-of-the-box GFI EventsManager supports events generated by various 
network devices manufactured by leading providers including Cisco and Juniper. For 
more information about supported devices visit:  

http://kbase.gfi.com/showarticle.asp?id=KBID002868. 

A built-in buffer allows the Syslog server to collect, queue and forward up to 30 
Syslog messages for batch processing. Buffered logs are by default passed on to the 
event processing engine as soon as the buffer fills up or at 1 minute intervals 
whichever comes first. 

http://kbase.gfi.com/showarticle.asp?id=KBID002868
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Figure 7 - Syslog messages must be directed to the computer running GFI EventsManager 

For Syslog message processing, ALL Syslog sources (e.g. workstations, servers, 
network appliances, etc.) must be configured to send their messages to the 
computer/IP where GFI EventsManager is installed. This applies also for the 
computer that is running GFI EventsManager, in GFI EventsManager, Syslog event 
processing parameters are configured as follows: 

1. Open up the (computer/computer group) properties dialog. 

2. Click on the Syslog tab. 

3. To enable the Syslog server and listen for messages sent by the computers in a 
computer group, select the option Accept Syslog Messages from this computer 
group. 

4. Click Advanced to enter a custom window code page. 

 

Windows code page -  is used to encode international characters to ASCII 
strings. Since Syslog is not Unicode compliant, GFI EventsManager uses 
a code page to decode the events. This is only applicable if GFI 
EventsManager is installed on a machine using a different language than 
the monitored machines. For a windows code list , refer to 
http://www.microsoft.com/globaldev/reference/wincp.mspx 

5. (Optional) Select Archive all scanned events in folder storage option, to archive 
events in the storage folder. For more information on how to configure the storage 
folder, refer to Configure storage folder section in this manual. 

 

Deleting events from source logs without archiving may lead to legal 
compliance issues. 

http://www.microsoft.com/globaldev/reference/wincp.mspx
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The GFI EventsManager Syslog server is by default configured to listen for 
Syslog messages on port 514. For more information on how to customize 
Syslog server port settings refer to Configuring the Syslog server 
communications port section in this chapter. 

 

The built-in Syslog server will only accept Syslog messages sent from the 
computers that are part of this computer group. 

Archiving Syslog events 

For information on how to archive events refer to Archiving events section in this 
manual. 

Selecting Syslog processing rules 

For information on how to select event processing rules refer to Selecting event 
processing rules section in this chapter. 

7.6  Configuring the Syslog server communications port 

To change the default Syslog ports settings: 

 
Screenshot 66 - Configuring Syslog Server 

1. Select Configuration tab 
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2. Select Options from the tab options. 

3. From the left pane, right-click the Syslog Server Options node and select Edit 
Syslog options… 

 
Screenshot 67- Syslog server properties 

4. Select Enable in-built Syslog server on TCP / UDP port: and specify the 
TCP/UDP port on which GFI EventsManager will receive/listen for Syslog messages. 

5. Select OK to finalize your settings. 

 

When configuring Syslog server port settings, make sure that the 
configured port is not already in use by other installed applications. This 
may affect the delivery of Syslog messages to GFI EventsManager. 
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7.7  Collecting and processing SNMP Traps 

 
Figure 8: SNMP Trap messages must be directed to the computer running GFI EventsManager 

SNMP is a data logging service that enables networked devices to log events and 
information through data messages (technically known as SNMP Traps). SNMP 
messaging technology is similar in concept to Syslogs - where unlike Windows and 
W3C log based environments, devices that generate SNMP messages do not record 
events data in local logs. Instead events information is sent in the form of data 
messages to an SNMP Trap Server which manages and saves SNMP message data 
in a local (centralized) log file. 

GFI EventsManager natively supports an extensive list of SNMP devices and 
Management Information Bases (MIBs). For a full list of supported devices visit: 
http://kbase.gfi.com/showarticle.asp?id=KBID002868. 

http://kbase.gfi.com/showarticle.asp?id=KBID002868
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Screenshot 68 - Computer group properties: SNMP processing parameters 

GFI EventsManager includes a dedicated SNMP Trap Server through which SNMP 
Traps are handled. A built-in buffer allows the SNMP Trap Server to collect, queue 
and forward up to 30 SNMP Trap messages for batch processing. Buffered logs are 
by default passed on to the event processing engine as soon as the buffer fills up or 
at 1 minute intervals whichever comes first. 

For SNMP Trap processing, ALL sources (e.g. workstations, servers, network 
appliances, etc.) must be configured to send their messages to the computer/IP 
where GFI EventsManager is installed. This applies also for the computer that is 
running GFI EventsManager, to configure SNMP processing parameters 

1. Open the computer/computer group properties dialog. 

2. Click on the SNMP Traps tab. 

3. To listen to SNMP messages via built-in SNMP Trap Server select the Accept 
SNMP Traps messages from this computer group option. 

 

Deleting events from source logs without archiving may lead to legal 
compliance issues. 
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The GFI EventsManager SNMP Trap Server is by default configured to 
listen for SNMP Trap messages on port 162. For more information on how 
to customize SNMP Trap Server port settings refer to Configuring the 
SNMP Trap server settings section in this chapter. 

 

The built-in SNMP Trap Server will only accept SNMP messages sent from 
the computers that are part of this computer group. 

 

The built in SNMP Trap Server supports SNMP version 3 Traps with 
encryption. For encrypted SNMP messages the encryption host key must 
be provided in the decrypt incoming SNMP Traps 3 message field 

Archiving SNMP Trap events 

For information on how to archive events refer to Archiving events section in manual. 

Selecting SNMP Trap processing rules 

For information on how to select event processing rules refer to Selecting event 
processing rules section in this manual. 

7.8  Configuring the SNMP Trap server settings 

To change the default SNMP Trap Server settings: 

 
Screenshot 69 - Configuring SNMP Traps 

1. Click on the Configuration tab and select Options. 
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2. From the left pane, right-click the SNMP Traps Options node and select Edit 
SNMP Traps options… 

 
Screenshot 70- SNMP Traps options 

3. Enable the required TCP/UDP SNMP server. Specify the TCP/UDP port on which 
GFI EventsManager will listen for SNMP messages. 

4. Click on the Advanced tab to add, edit or remove SNMP Trap object identifiers 
(OIDs). 

5. Click Specific Trap Type tab to add, edit or remove trap types. 

6. Click OK to finalize your configuration settings. 

 

When configuring SNMP Trap Server port settings, make sure that the 
configured TCP or UDP port is not already in use by other installed 
applications. This may affect the delivery of SNMP Trap messages to GFI 
EventsManager. 
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7.9  Archiving events 

Archive events without processing logs 

 
Screenshot 71 - Archiving events without processing 

By default, GFI EventsManager is configured to process all event logs collected from 
target computers.  

Archiving events after processing 

 
Screenshot 72 - Archiving events after processing 

Processed events can be archived into the GFI EventsManager database backend 
and\or stored in a storage folder. By default, GFI EventsManager can be configured 
to automatically archive events: 

 Based on their classification. For example, you can configure default settings 
which archive only critical events. For information on how to configure event 
archiving based on event classification refer to Configuring default classification 
actions section in this manual. 

 Based on the conditions configured in the event processing rules. Rules provide 
an alternative and more flexible way to archive processed events. Through these 
rules, you can selectively archive only those events that satisfy specific rule 
condition(s) - regardless their classification. For example, you can configure a 
rule which archives only critical events with ID 537. For more information on how 
to create and configure event processing rules refer to Managing event 
processing rules chapter in this manual. 
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After collecting the events, GFI EventsManager can be configured to store the 
collected events into a storage folder, this can be done by selecting Archive all 
scanned events in folder storage. The storage folder path can be configured from 
the Configuration tab, for more information refer to Configure storage folder. This 
feature allows the administrator to store all the events in a storage folder and store 
only important events (that trigger rules) in the database. 

 

When configuring SNMP Trap Server port settings, make sure that the 
configured TCP or UDP port is not already in use by other installed 
applications. This may affect the delivery of SNMP Trap messages to GFI 
EventsManager. 

 

For more information on how to retrieve archived events from the storage 
folder, refer to Import from file section in this manual. 

7.10  Selecting event processing rules 

 
Screenshot 73 - Computer group properties: Configuring Windows Event Logs parameters 

In order to process and classify events, you must specify which rules will be applied 
against the collected logs. This is achieved by selecting the rule-sets folder or rule-
set (s) that contain the required event processing rules. 
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Screenshot 74 - Selecting event processing rules/rule-sets 

However, you must pay attention and choose the right “rule” for the job. The rule-sets 
that ship with GFI EventsManager are pre-configured to specific logs; therefore it is 
imperative that you choose rule-sets that can effectively process the events recorded 
in the collected logs. 

Certain rule-sets contain specialized rules that are event specific. Therefore these 
rules will only be effective when used to process such specific events; failing to do so 
will result into erroneous event processing, data loss and non-significant results. For 
example, the „Monitoring and Attack detection‟ rule-set contains rules specifically built 
to process Windows Security events. Therefore it will not be very effective if used to 
process Windows application events. 

 

By default, GFI EventsManager ships with pre-selected rules-sets/folders 
that can effectively process Windows Event Logs. If you are new to the 
product or you are not yet acquainted with the functionality of rule-sets, we 
recommend that you leave these settings as default. 

 

If no rules-sets are shown in the selection window, this means that no 
event processing rules exist for the type of log being configured. For more 
information on how to configure event processing rules and rule-sets, refer 
to Using event processing rules chapter. 
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7.11  Configure storage folder 

GFI EventsManager can be configured to archive events in a storage folder after 
applying processing rules. This feature allows the system to store all the events 
retrieved from event sources, on the local host (where GFI EventsManager is 
installed). To configure the storage folder: 

1. Click Configuration ► Options. 

2. From the left panel click Database Backend node. 

3. From the right panel click Change files folder backend. 

4. Key in a name for the archive file. 

5. Click Browse to locate the path where the archive file will be saved. 

6. Click OK to apply settings. 

 

Screenshot 75 – Configure file folder 
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7.12  Triggering event source scanning manually 

In GFI EventsManager, you can manually trigger an event collection iteration on 
target computers. To achieve this: 

1. Right-click on the computer group which contains the required event sources. 

2. Select Scanning options ► Scan now. 

 
Screenshot 76 - Triggering log collection manually 
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8 Managing event processing rules 

8.1  Introduction 

Event processing rules are the conditions which: 

 Classify processed events 

 Filter out noise (repeated events) or unwanted events 

 Trigger email, SMS and network alerts on key events 

 Attempt remedial actions by executing specific scripts and executable files on key 
events. 

GFI EventsManager ships with pre-configured rules that can be used to process 
events with minor configuration effort. You can also customize these default rules or 
create tailored ones for all supported log types (i.e. Windows Event Logs, W3C, 
Syslog, SNMP Traps and SQL Server audit logs). 

In GFI EventsManager, event processing rules are organized into rule-sets, which in 
turn are stored in rule-set folders. The pre-configured rules that ship with GFI 
EventsManager are described in Table 4 below. 

Table 4 - Rule-set folders available in GFI EventsManager 

Rule-set folder Description 

Noise reduction rules 
Contains rules tailored for the removal of repeated events and other 
noise from logs. 

PCI requirements 
Windows OS 

Contains rules tailored for PCI DSS compliance 

Security 
Contains rules tailored for the processing of Security logs and System 
logs. 

System Health 
Contains rules tailored for the processing of Application logs and System 
logs. 

Security Applications 
Contains rules tailored for the processing of Application logs, Security 
logs and System logs. 

Infrastructure Server 
Contains rules tailored for the processing of Application logs, DNS logs 
and System logs. 

Database Server Contains rules tailored for the processing of Application logs. 

Web Server 
Contains rules tailored for the processing of Application logs and System 
logs. 

Print Server 
Contains rules tailored for the processing of Application logs and System 
logs. 

Terminal Services 
Contains rules tailored for the processing of events generated terminal 
device driver services. 

Email Server 
Contains rules tailored for the processing of events generated by 
Microsoft Exchange server. 
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Rule-set folder Description 

File Replication 
Contains rules tailored for the processing of events generated by file 
replication services. 

Directory Server 
Contains rules tailored for the processing of events found in the 
Directory Services log. 

HTTP protocol logs 
Contains rules tailored for the processing of HTTP events logged by IIS 
Web Server(s) 

FTP protocol logs 
Contains rules tailored for the processing of FTP events logged by IIS 
Web server(s) 

SMTP protocol logs 
Contains rules tailored for to monitor events logged by ISS SMTP 
server(s). 

Linux/Unix Contains rules tailored for the processing of Syslogs. 

Cisco PIX & ASA 
Contains rules tailored for the processing of events generated by Cisco 
PIX firewalls and Cisco Adaptive Security Appliances 

8.2  Create a new rule-set folder 

 
Screenshot 77 - The log type drop-down list 

To create a new rule-set folder: 

1. Click on the Configuration tab and select Event Processing Rules. 

2. From the provided drop-down, select the log-type for which you will be creating the 
rule-set folder. 

3. Select the Create folder option from the Common tasks area in the left pane. 

4. Specify a unique name for the new rule-set folder. 

8.3  Renaming and deleting folders 

To rename or delete existing rule-set folders, right-click on the target rule-set folder 
and select Rename or Delete accordingly. 

 

Deleting a rule-set folder will lead to the deletion of all the rules and rule-
sets contained within the deleted folder. 
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8.4  Creating a new rule-set 

To create a new rule-set: 

1. Click on the Configuration tab and select Event Processing Rules. 

2. From the provided drop-down, select the log-type for which you will be creating the 
new rule-set. 

3. Right-click on the folder where to create the new rule-set and select Create new 
rule set…. 

 
Screenshot 78 - New rule-set dialog box 

4. Specify a name and a description for this new rule-set. 

5. Click OK to finalize your settings. 

8.5  Editing a rule-set 

To edit rule-set parameters: 

1. Right-click on the rule-set to edit and select Properties. 

2. Make the required changes and click OK to finalize your settings. 
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8.6  Deleting a rule-set 

To delete a rule-set, right-click on the rule-set and select Delete. 

8.7  Creating a new Windows Event Log rule 

To create a new rule which is only applicable to Windows Event Logs: 

1. Click on the Configuration tab and select Event Processing Rules. 

 
Screenshot 79 - Selecting log-type from the provided drop-down 

2. Select Windows Event Logs from the drop down list. 

3. Right-click the rule-set where the log rule will be created and click Create new 
rule… 

4. Specify the name and a description for the new rule. Click Next to proceed with 
the configuration. 

 
Screenshot 80 - GFI EventsManager: Select the Log(s) 
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5. Select the event logs to which the rule applies and click Next. 

 
Screenshot 81 - GFI EventsManager: Select the filtering conditions 

6. Configure the event filtering conditions of this rule. To create a rule which will be 
applied to all events, leave the event ID empty. Click Next to continue. 

 

To filter events that refer to an administrator user (events having the 
security identifier SID that identifies a logon administrator session), ensure 
that if the target is a domain member, the domain controller must be added 
as a target machine and scanned. For more information on how to add a 
target machine, refer to Adding new event sources to the computers group 
section in this manual. 

7. (Optional) Click Advanced to configure advanced filtering conditions. For more 
information refer to Advanced event filtering parameters section in this manual. 
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Screenshot 82 - New processing rule wizard: Select event occurrence and importance 

8. Specify the time when this rule will be executed. (i.e. anytime, during working 
hours or outside working hours). 

 

Working and non-working hours are based on the operational time 
parameters configured for your event sources. For more information on 
how to configure operational times, refer to Configuring event source 
operational time chapter. 

9. Select the classification (critical, high, medium, low or noise) that will be assigned 
to events that satisfy the conditions in this rule. Click Next to continue. 



 

GFI EventsManager manual Managing event processing rules  103 

 
Screenshot 83 - New processing rule wizard: Select action 

10. Specify which actions will be triggered by this rule. Actions available are: 

 Ignore the event 

 Use the default classification actions 

 Use an action profile.  

If Use the following actions profile is selected, click Edit to configure and select 
actions to perform.  

11. Click Next to proceed to the final dialog. Click Finish to finalize your settings. 

 

Newly created rules are disabled by default and will NOT become 
operational unless enabled. For information on how to enable event 
processing rules refer to Collecting and processing Windows events 
section in this Manual. 
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8.8  Creating a new W3C rule 

To create a new rule which is only applicable for W3C logs: 

1. Click on the Configuration tab and select Event Processing Rules. 

2. From the provided drop-down, select W3C Logs. 

3. Right-click on the rule-set in which you will be creating the new rule and select 
Create new rule… 

4. Specify a name and description for the new rule. Click Next to proceed with the 
configuration. 

 
Screenshot 84 - New processing rule wizard: Select W3C Log 

5. Click on the Add button. Specify the path to the W3C logs for which this rule 
applies or leave blank to apply this rule to all W3C logs. Click Next to continue. 

 

Multiple paths can be specified during configuration. 
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Screenshot 85 - New processing rule wizard: Configure filtering conditions. 

6. Click Add button and configure event filtering conditions. Repeat until all 
conditions have been specified. Click Next to continue. 

 

Screenshot 86 – Edit filter rules 
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Screenshot 87 - New processing rule wizard: Select event occurrence and importance 

7. Specify the time when this rule will be executed. (i.e. anytime, during working 
hours or outside working hours). 

 

Working and non-working hours are based on the operational time 
parameters configured for your event sources. For more information on 
operational times, refer to Using event processing rules section in this 
manual. 

8. Select the classification (critical, high, medium, low or noise) that will be assigned 
to events that satisfy the conditions in this rule. Click Next to continue. 
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Screenshot 88 - New processing rule wizard: Select action 

9. Specify which actions will be triggered by this rule. You can choose to ignore the 
event, trigger the default action, or customize alerts. 

10. Click Next to proceed to the final dialog. Click Finish to finalize your settings. 

 

Newly created rules are disabled by default and will NOT become 
operational unless enabled. For information on how to enable event 
processing rules refer to Collecting and processing W3C logs section in 
this Manual. 

8.9  Creating a new Syslog rule 

To create a new rule that is only applicable for the processing of Syslog messages: 

1. Click on the Configuration tab and select Event Processing Rules. 

2. From the provided drop-down, select Syslog. 

3. Right-click on the rule-set in which you will be creating the new rule and select 
Create new rule… 

4. Specify the name and a description for the new rule. Click Next to proceed with 
the configuration. 
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Screenshot 89 - New processing rule wizard: Configure Conditions 

5. Specify the log filtering conditions to be processed by this rule. When all conditions 
have been specified, click Next. 

 
Screenshot 90 - New processing rule wizard: Select event occurrence and importance 
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6. Specify the time when this rule will be executed. (i.e. anytime, during working 
hours or outside working hours). 

 

Working and non-working hours are based on the operational time 
parameters configured for your event sources. For more information on 
operational times, refer to Configuring event source operational time 
section in this manual. 

7. Select the classification (critical, high, medium, low) that will be assigned to events 
that satisfy this rule. Click Next to continue. 

 
Screenshot 91 - New processing rule wizard: Select action 

8. Specify which actions will be triggered by this rule. You can choose to ignore the 
event, trigger the default action, or customize alerts. 

9. Click Next to proceed to the final dialog. Click Finish to finalize your settings. 

 

Newly created rules are disabled by default, hence will NOT become 
operational unless enabled. For information on how to enable event 
processing rules refer to Collecting and processing Syslogs section in this 
Manual. 
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8.10  Creating a new SNMP Trap rule 

To create a new rule that is only applicable for the processing of SNMP Traps: 

1. Click on the Configuration tab and select Event Processing Rules. 

2. From the provided drop-down, select SNMP Traps logs. 

3. Right-click on the rule-set in which you will be creating the new rule and select 
Create new rule… 

4. Specify the name and a description for the new rule. Click Next to proceed with 
the configuration. 

 

Screenshot 92 - New processing rule wizard: Configure Conditions  

5. Specify the log filtering conditions to be processed by this rule. When all conditions 
have been specified, click Next. 
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Screenshot 93 - New processing rule wizard: Select event occurrence and importance 

6. Specify the time when this rule will be executed. (i.e. anytime, during working 
hours or outside working hours). 

 

Working and non-working hours are based on the operational time 
parameters configured for your event sources. For more information on 
operational times, refer to Configuring event source operational time 
section. 

7. Select the classification (critical, high, medium, low) that will be assigned to events 
that satisfy this rule. Click Next to continue. 
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Screenshot 94 - New processing rule wizard: Select action 

8. Specify which actions will be triggered by this rule. You can choose to ignore the 
event, trigger the default action, or customize alerts. 

9. Click Next to proceed to the final dialog. Click Finish to finalize your settings. 

 

Newly created rules are disabled by default, hence will NOT become 
operational unless enabled. For information on how to enable event 
processing rules refer to Collecting and processing SNMP Traps section in 
this Manual. 

8.11  Creating a new SQL Server audit log 

To create a new rule that is only applicable for the processing of SQL Server audit 
logs: 

1. Click on the Configuration tab and select Event Processing Rules. 

2. From the provided drop-down, select Microsoft SQL Server audit. 

3. Right-click on the rule-set in which you will be creating the new rule and select 
Create new rule… 

4. Specify the name and a description for the new rule. Click Next to proceed with 
the configuration. 
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Screenshot 95 - New processing rule wizard: Configure Conditions 

5. Specify the log filtering conditions to be processed by this rule. When all conditions 
have been specified, click Next. 
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Screenshot 96 - New processing rule wizard: Select event occurrence and importance 

6. Specify the time when this rule will be executed. (i.e. anytime, during working 
hours or outside working hours). 

 

Working and non-working hours are based on the operational time 
parameters configured for your event sources. For more information on 
operational times, refer to Configuring event source operational time 
section. 

7. Select the classification (critical, high, medium, low) that will be assigned to events 
that satisfy this rule. Click Next to continue. 
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Screenshot 97 - New processing rule wizard: Select action 

8. Specify which actions will be triggered by this rule. You can choose to ignore the 
event, trigger the default action, or customize alerts. 

9. Click Next to proceed to the final dialog. Click Finish to finalize your settings. 

8.12  Create new rule from an existing event 

GFI EventsManager allows the creation of a new rule from an existing Windows 
Event.  

8.12.1 Create new rule from event 

To create a new rule from an existing Windows Event: 

1. Select Events Browser ► Windows Events Browser 

2. Right click the event and select Create rule from event. 
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Screenshot 98 – Create rule from event 

3. In the rule properties dialog box, key-in a valid name and an optional description. 

 

Screenshot 99 – New Rule dialog 
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Screenshot 100 –Updated conditions for the selected rule 

4. Select the Conditions tab and update the fields as required. 

 

Conditions such as Event ID, Source and Category are updated 
automatically from the selected Windows event. 

5. Select the Actions tab and configure the type of action to perform when the event 
occurs. You can choose to ignore the event, trigger the default action, or customize 
alerts. 

6. Click Ok to save and close the rule dialog. 

8.12.2 View or Edit the custom rule 

To view or edit the new rule created: 

1. Click Configuration tab, select Log Type. 

2. From the Rule Sets list, locate and click the Custom Rules folder. 

3. Click Custom rule set rule and in the right panel locate the new rule created. 

4. Right click the rule to: 

 Disable 
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 Delete 

 Increase or decrease priority 

 Edit properties. 

 

Screenshot 101 – Edit an existing custom rule 
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8.13  Changing the configuration settings of a rule 

 
Screenshot 102 - Log processing rule properties 

To edit the property settings of an event processing rule: 

1. Right-click on the rule and select Properties. 

2. Use the tabs provided in the dialog to navigate the existing parameters and make 
the required changes. The tabs provided in the properties dialog include: 

 General - Use this tab to configure the general properties of the rule including the 
rule name and rule classification. 

 Logs - This tab is available only for W3C log rules. Use this tab to specify the 
W3C logs for which this rule applies. 

 Event Logs - This tab is available only for Windows Event Log rules only. Use 
this tab to specify which events will be processed by this rule. 

 Conditions - Use this tab to configure event filtering conditions. 

 Actions - Use this tab to configure alerts and actions triggered by this rule. 

 Threshold - Use this tab to configure the event threshold value i.e. the number of 
times that an event must be detected prior to triggering alerts and remedial 
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actions. This helps reducing false positives triggered by noise (repeated events) 
in your event logs. 

8.14  Advanced event filtering parameters 

GFI EventsManager allows systems administrators to set up advanced event filtering 
parameters. These options are available only for Windows Events and Syslogs. 

8.14.1 Windows events conditions 

The Event IDs: field allows systems administrators to setup parameters described in 
Table 5 below.  

Table 5 - Parameters available in the Event ID field 

Parameter type Example 

Single events 
 

List of events 
 

Range of events 
 

Combination of events 
 

 

The Source, Category and User fields allow systems administrators to setup 
parameters described in Table 6 below.  

Table 6 - Parameters available in the Source, Category and User fields 

Parameter type Example 

Single source name 
 

List of sources 
 

Wildcards (% and *) 
 

 

8.14.2 Syslog categories 

The Message and Process fields allow systems administrators to setup parameters 
described in Table 7 below. 

Table 7 - Parameters available in the Message and Process fields 

Parameter type Example 

Single message 
 

List of messages 
 

Wildcards (% and *) 
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8.14.3 Field operators 

Field operators are used in advanced filtering. Filters process events based on the 
field operator and a value, configured by the user. Available field operators, include: 

 Equal to - When the event field is equal to the value configured. 

 Not Equal to - When the event field is not equal to the value configured. 

 Contains the text -When the event field contains the value text. 

 Does not contain the text - When the event field does contains the value text. 

 Like - When the event field has similar text as the value text. 

 Value in set - When the event field is equal to one of the values in a list. 

 Value not in set - When the event field is not equal to one of the values in a list. 

 

To create a list in the value field, enter all items separated by a semicolon 
„;‟. 

 

Screenshot 103 - Available field operators 

 



 

122  Customizing alerts and actions GFI EventsManager manual 

9 Customizing alerts and actions 

9.1  Introduction 

During event processing, GFI EventsManager can automatically generate various 
actions whenever particular events are encountered. Supported actions include email 
alerts and event archiving. 

You can specify alerts and actions to be triggered in two ways: 

1. By configuring a set of „Default classification actions „. 

2. By creating or customizing rules and rule-sets. 

Default classification actions 

Through the configuration parameters provided in the default classification actions, 
you can trigger alerts and actions based only on event classification. For example, 
default classification parameters can be configured to trigger email alerts for all 
classified events (critical, high, medium and low) but archive only critical events. 

Generating actions through event processing rules 

Rules allow you to configure actions on a more granular level. Rules allow you to 
configure and trigger actions whenever an event fits one or more specific conditions. 
For example, you can create a rule which archives only events having event ID 231, 
regardless their classification. 

Supported actions 

GFI EventsManager supports the following actions: 

 Archive the event - Archives the classified event into the GFI EventsManager 
database back-end. 

 Send e-mail, SMS, network or SNMP notifications to - Sends email, SMS 
network or SNMP alerts to specific recipients. 

 Run File - Runs an executable file. Files that can be executed include VBScripts 
(.VBS), Batch files (.BAT) or another executable type of file (.EXE). You can also 
specify any command-line parameters to pass on to the executable file. 
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9.2  Configuring default classification actions 

 
Screenshot 104 - Configuring default classification actions 

To configure default classification actions: 

1. Click the Configuration tab and select Options. 

2. From the left pane, right-click on the Default Classification Actions node and 
select Edit defaults… option. 
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Screenshot 105 - Default classification actions screen 

3. From the provided drop-down, select the event classification to be configured. 

4. From the provided list of supported actions, select the ones to be triggered for the 
selected classification. 

5. Click on the Configure button specifies any parameters required by the selected 
action. 

Be aware that assigning actions on events classified as low might generate: 

 A lot of network traffic (especially if email, SMS, network or SNMP alerts are 
being generated) 

 A high volume of database data/transactions if events are being archived. 

9.3  Configuring actions through event processing rules 

For more information on how to trigger actions through event processing rules refer 
to Using event processing rules section in this manual. 

9.4  Configuring alerting options 

GFI EventsManager will automatically send out email, network, SMS or SNMP alerts 
whenever particular events are discovered. Supported alerting methods require the 
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configuration of a set of general alerting parameters that are network specific. For 
example, to send email alerts, GFI EventsManager must know which SMTP Server 
will be used to propagate email alerts. 

 

While GFI EventsManager issues alerts automatically whenever particular 
alerts are discovered, it is important to configure the email address/es of 
the recipients of such alerts. By default, GFI EventsManager will 
automatically create the EventsManagerAdministrator account to which 
you can assign an email address. For more information on how to 
configure administrator contact details refer to Configuring the 
administrator account section in this manual. 

 
Screenshot 106 - Configuring alerting options 

To configure alerts: 

1. Click the Configuration tab and select Options. 

2. From the left pane, right-click on the Alerting Options node and select Edit 
alerting options… option. 
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Screenshot 107 - Alerting options dialog 

This will launch the Alerting Options dialog. Use the Email, Network, SMS and 
SNMP tabs provided in this dialog to configure the default alerting settings. More 
information on how to configure these settings is provided below. 
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9.4.1 Configuring email alerts 

 
Screenshot 108- Mail server properties dialog box 

To configure email alerts: 

1. From the Email tab which opens by default, click on the Add button. 

2. Specify the name/IP of your mail server. If required specify also the mail server 
authentication details. 

3. Specify the email address and display name that will be used when sending email 
alerts. 

4. To customize the email text message, click on the Format Email Message… 
button. 
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Screenshot 109- Format mail message 

5. If required, click on the Network, SMS or SNMP tabs to configure the respective 
parameters. 

6. Click OK to finalize your settings. 

9.4.2 Configuring network alerts 

 
Screenshot 110 - Alerting Options: Network dialog box 
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1. Access the Network tab 

2. No configuration settings are required for network alerts from this dialog. However, 
you can customize the network message by clicking on the Format network 
message… button. 

9.4.3 Configuring SMS alerts 

 
Screenshot 111 - Alerting Options: SMS dialog box 

SMS alerts can be sent using various methods. Supported methods include GFI 
FAXmaker SMS gateway and Clickatell Email to SMS service gateway. To configure 
which method will be used to convey SMS alerts: 

1. Access the SMS tab 

2. From the provided drop-down, select the SMS system through which SMS 
notification will be sent. 

3. Select the property to be configured from the list provided and click Edit… 

4. Repeat until all required properties have been configured. 

5. To customize the SMS alert message, click Format SMS message…. 

6. Click on OK to finalize your settings. 
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9.4.4 Configuring SNMP alerts 

 
Screenshot 112 - Alerting Options: SNMP dialog box 

To configure SNMP alerts: 

1. Access the SNMP tab 

2. Specify the IP address where SNMP alerts will be sent. 

3. Optionally specify the port/s that will be used to send the SNMP alerts. 

4. To customize the email text message, click on the Format SNMP Message… 
button. 

5. Click OK to finalize your settings. 
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10 Configuring users and groups 

10.1  Introduction 

 
Screenshot 113 - Configuring users and groups node 

Use the Users and Groups node to assign different console access privileges to GFI 
EventsManager users. Through this node users and groups can be configured, 
amended or deleted. Working hours and alerts can also be configured and assigned 
to groups. 

Use the users and groups node also to assign users administrative privileges. These 
privileges allow users to browse events as well as modify GFI EventsManager 
configuration settings. 

10.2  Configuring the administrator account 

GFI EventsManager will automatically create the „EventsManagerAdministrator „ 
account. However, you must still configure details such as the email address and 
mobile number of the GFI EventsManager administrator. 

 

GFI EventsManager requires a valid administrator email address in order 
to distribute automatic alerts when particular events are discovered. 
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For every user (including the administrator), you can configure the following 
parameters: 

 Contact details including email address and phone number 

 The typical working hours 

 The type of alert to send during and outside working hours 

 The notification group to which the user belongs. 

 
Screenshot 114 - Configuring the default EventsManagerAdministrator account 

To configure the GFI EventsManagerAdministrator account: 

1. Click on the Configuration tab and select Options. 

2. Expand the Users and Groups node. 

3. Click on the Users sub-node and in the right pane right click on the 
EventsManagerAdministrator account and select Properties. 
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Screenshot 115 - EventsManager Administrator properties 

Configuring the account sequence is as follows: 

1. Specify the contact details such as email address, and mobile number as required. 

2. Specify the computers on which network alerts addressed to the administrator will 
be sent. 

3. Click on the Working Hours tab. 
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Screenshot 116 - Configuring the typical working hours of an alert recipient 

4. Select the typical working hours of the administrator/user. 
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Screenshot 117 - Selecting alerts to be sent during and outside working hours 

5. Click on the Alerts tab and select which alerts will be sent during and outside 
working hours. 
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Screenshot 118 - Notification groups to which a user belongs 

6. Click on the Member Of tab and select the notification groups to which the user 
belongs. By default the administrator is a member of the 
„EventsManagerAdministrators‟ notification group. 
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Screenshot 119 - Configuring GFI EventsManager administrator privileges  

7. Click the Privileges to modify the user privileges on GFI EventsManager. By 
default the „EventsManagerAdministrator‟ account has full privileges. 

8. Click on the OK button to finalize your settings. 

10.3  Creating a new user 

GFI EventsManager allows you to create a custom list of users which you can 
organize into groups to speed up administrative tasks. 

To create a new user: 

1. Click on the Configuration tab and select Options. 

2. Expand the Users and Groups node. 

3. Right-click on the Users sub-node and select Create user… 

4. Specify the parameters requested in the General, Working Hours, Alerts 
Member of and Privileges tabs. 

 

For more information on how to fill in these tabs, refer to Configuring the 
administrator account section in this manual. 
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Screenshot 120 - GFI EventsManager new user privileges 

5. Click on the Privileges tab and select user privileges accordingly. E.g. To assign 
administrative privileges to a user select the This user has full privileges option. 

 

Users with administrative privileges can modify all GFI EventsManager 
configuration settings. 

6. Click OK to finalize setup. 

10.4  Changing user properties 

To edit user properties: 

1. From the left pane, click on the Users node. 

2. Right-click on the user to edit and select Properties. 

3. Make the required changes in the tabs available and click OK to finalize your 
settings. 

 

For more information on how to fill in these tabs, refer to Configuring the 
administrator account section in this manual. 
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10.5  Deleting users 

To delete a user: 

1. From the left pane, click on the Users node. 

2. From the right viewer pane, right-click on the user to be deleted and select Delete. 

10.6  Configuring groups 

 
Screenshot 121 - Groups configuration screen 

1. Click on the Configuration tab and select Options. 

2. Expand the Users and Groups node. 

3. Right-click on the Groups sub-node and select Create group… 
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Screenshot 122 - New groups setup 

4. Specify the name of the new group. 

5. Click Add to start adding users to the group. 

6. Click OK to finalize your settings. 

10.6.1 Changing user group properties 

To edit the settings of a user group do as follows: 

1. From the left pane, click on the Groups node. 

2. From the right pane, right-click on the group to be configured and select 
Properties. 

3. Perform the required changes in the tabs available and click OK to finalize your 
settings. 

10.6.2 Deleting user groups 

To delete a user group: 

1. From the left pane, click on the Groups node. 

2. From the right viewer pane, right-click on the group to be deleted and select 
Delete. 
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10.7  Enabling and disabling the GFI EventsManager login system 

1. Click on the Configuration and select Options. 

 

Screenshot 123 - Select the login options feature 

2. Expand the Console Security and Audit Options node, click on the Security 
Options node and select Edit security options…. 
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Screenshot 124 - Login options dialog 

3. Select/unselect the Enable EventsManager login system option accordingly. 

4. Click OK to finalize your settings. 

 

When the login system is enabled all users will be asked to specify their 
credentials every time they launch the GFI EventsManager management 
console. 

 

Users are granted access with administrative or user privileges according 
to the user privileges set up in the privileges tab within the user setup 
dialogs. 

 

To configure or edit a user password, from Configuration ►Users and 
Groups ► Users, right click the user account and select Change 
Password. 

10.7.1 Password recovery  

When GFI EventsManager login system is enabled, all users are requested to enter a 
valid user name and password to access GFI EventsManager console. 



 

GFI EventsManager manual Configuring users and groups  143 

 
Screenshot 125 - Login window 

If a password is forgotten or lost: 

1. Key in your username. 

2. Click Forgot your password? Link 

GFI EventsManager will send an email containing your login password. 

 

The User must have a valid email address configured in GFI 
EventsManager to receive the password by email. For more information on 
how to change user settings including the email address, refer to Changing 
user properties in this chapter. 
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10.8  Enabling and disabling user action auditing 

1. Click on the Configuration tab and select Options. 

 
Screenshot 126 - Select the Audit options feature 

2. Expand the Console Security and Audit Options node, click on the Audit 
Options node and select Edit audit options…. 
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Screenshot 127 - Audit Options 

3. Select Audit all the actions done by users option and specify the location where 
the output log file will be saved. 

4. Click OK to finalize settings. 
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11 Status monitoring 

11.1  Introduction 

The status monitor is a dashboard that shows the status of GFI EventsManager as 
well as provides you with statistical information related to the events collected, 
processed and archived by this product. The status monitor consists of three different 
dashboard views: General view, Job Activity view and Statistics view. 

11.2  Accessing the status monitor 

 
Screenshot 128 - Dashboard View Options 

To access the status monitor click on the Status tab and select the required 
dashboard view.  
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11.3  General status view 

 
Screenshot 129 - GFI EventsManager status: General view 

Use the General option to: 

 View the status of the GFI EventsManager event processing engine. 

 Access statistical information such as the number of logon events, critical events 
and service status events. 

 

Click the Arrange Window icon  to automatically fit all graphs in the 
management console. 

11.3.1 GFI EventsManager service status 

 
Screenshot 130 - GFI EventsManager General Status view: Service Status 

This section shows: 
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 The operational status of GFI EventsManager service/event processing engine 

 The operational status of the Syslog server 

 The operational status of the SNMP Traps server 

 The operational status of the database server currently in use by GFI 
EventsManager 

 

The GFI EventsManager service will not start if a database backend is not 
currently configured. 

 

Click the service name to edit the service settings 

11.3.2 Top Important Logon Events 

 
Screenshot 131 - GFI EventsManager General Status view: Important logon events  

This section provides statistical information about: 

 Top 10 successful Logon events outside working hours 

 Top 10 important Logon events during working hours 

 Top 10 failed Logon events 

Events in this section are filtered by: 

 Machine – select a machine or key-in a machine name in the drop down list. 

 Date - select a specific date or a day period from the drop down list. 

To view events in the Events Browser, click View Events. For more information on 
how to use the Event Browser, refer to Event browsing chapter in this manual. 
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Double click the graph to open the graph in a new window. When a 3D 
graph is selected, the new window allows you to rotate, zoom or resize the 
graph. 

11.3.3 Top Critical and high Importance events 

 
Screenshot 132 - GFI EventsManager General Status view: Critical events 

This section provides statistical information about the top 10 critical events. From the 
drop down lists, select the type of information to display: 

 Events - the most frequent (top 10) critical events occurred during a time period.  

 Machines - the top 10 machines that generated the most critical events during a 
time period.  

To view events in the Events Browser, click View Events. For more information on 
how to use the Event Browser, refer to Event browsing chapter in this manual. 

 

Double click the graph to open the graph in a new window. When a 3D 
graph is selected, the new window allows you to rotate, zoom or resize the 
graph. 

11.3.4 Events Count by Database Fill-Up 

 
Screenshot 133 - GFI EventsManager General Status view: Service Status 
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This section displays: 

 The horizontal bars represent the number of events stored in the database 
backend, sorted by event log type. 

 The date and time of the last backup 

 The date and time of the next scheduled backup. 

The bar color turns from green to red as the database is populated with events. It is 
recommended to perform a backup when the horizontal bar reaches the full (red) 
status. For more information on how to create a new database backup and 
maintenance jobs, refer to Creating maintenance jobs section in this manual. 

Backup and Clean now 

To start a backup operation: 

1. Click the Backup and Clean now button. 

2. Select which events should be backed up and click Backup and clean now. 

 
Screenshot 134 - GFI EventsManager Backup logs 

 

If the Backup and Clean now button is disabled, create a new database 
operation job. For more information on how to create a new database 
operation, refer to Creating maintenance jobs section in this manual. 
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11.3.5 Top Services Status Events 

 
Screenshot 135 - GFI EventsManager General Status view: Services Status 

This section displays the top 10 services that caused the selected event. A service 
can generate events when: 

 Terminated with an error 

 Failed to load 

 Failed to start 

 Timed out 

 Stopped 

 Started 

The graph shows the frequency of these events sorted by service type or\and by 
computer generating the event. Select a machine or service from the drop down lists 
or key-in the required criteria to customize the graph results. 

To view events in the Events Browser, click View Events. For more information on 
how to use the Event Browser, refer to Event browsing chapter in this manual. 

 

To collect services information, target machines must have Audit system 
events policy enabled. For more information on how to enable this audit 
policy, refer to Step 2: Enable additional auditing features section in this 
manual. 

 

Double click the graph to open the graph in a new window. When a 3D 
graph is selected, the new window allows you to rotate, zoom or resize the 
graph. 
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11.3.6 Top Network Activity Events 

 
Screenshot 136 - GFI EventsManager General Status view: Network Activity 

This section displays details of the top 10 network activities (inbound and outbound) 
generated by target machines. Network activity consists of all type of traffic that is 
generated by various protocols including SMTP, HTTP, FTP and MSN traffic. The 
network activities displayed can be filtered by: 

 Applications 

 Source Addresses 

 Destination Addresses 

 Computers 

 Ports 

 Users 

Select parameters from the drop down lists or key-in the values to filter the type of 
chart displayed.  

 

The network activity shown in the chart applies only to computers running 
Microsoft Windows Vista or later. 

 

To collect network activities, target machines must have Object auditing 
and Process tracking enabled. For more information on how to enable 
these audit policies, refer to Step 2: Enable additional auditing features 
section in this manual. 
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11.4  Job activity view 

 
Screenshot 137 - GFI EventsManager Job Activity view 

Use the Job Activity option to view your current event collection and processing 
activity. This includes active event collection jobs as well as Syslog messaging 
history on a machine by machine. 

The information provided in this view is divided into dedicated sections. More details 
on these sections are provided below. 



 

154  Status monitoring GFI EventsManager manual 

Active jobs 

 
Screenshot 138 - GFI EventsManager Job Activity view: Active Jobs 

This section shows a list of all event collection jobs currently taking place on every 
event source/machine. The information provided includes the job progress as well as 
the Log Source from which events are being collected. 

Queued jobs 

 
Screenshot 139 - GFI EventsManager Job Activity view: Queued Jobs 

This section shows a list of all pending event collection jobs on a machine by 
machine basis. The information provided includes the Log Source from which events 
will be collected as well as the time that these jobs were queued. 

Server message history 

 
Screenshot 140 - GFI EventsManager Job Activity view: Server Message History 

This section shows a list of all server messages (SNMP Traps and Syslog) that were 
received by GFI EventsManager. The information provided includes the total number 
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of messages sent by every source machine and the date/time when the last message 
was received. 

Operational history 

 
Screenshot 141 - GFI EventsManager Job Activity view: Operational History 

This section shows an audit trail of the event collection operations carried out by GFI 
EventsManager. The information provided includes errors and information messages 
generated during the event collection process as well as the name of the log file that 
was being processed on the source machine. 

Maintenance jobs 

 
Screenshot 142 - GFI EventsManager Job Activity view: Job activity status 

This section shows the progress of maintenance jobs that have been created through 
Database Operations. The information provided includes the job description as well 
as the time when the job began execution. 
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11.5  Statistics view 

 
Screenshot 143 - GFI EventsManager Statistics view 

Use the Statistics option to view the daily event activity trends and statistics of a 
particular computer or of your entire network. 

The information provided in this view is divided into dedicated sections. More details 
on these sections are provided below. 

Events count for today 

 
Screenshot 144 - GFI EventsManager Statistics view: Events Count For Today 

This section graphically represents the daily event collection trend on a machine by 
machine basis as well as on a network by network basis. A color scheme is used to 
differentiate between Windows, W3C, Syslog and SNMP Traps events. 
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Events count by log type 

 
Screenshot 145 - GFI EventsManager Statistics view: Events count by log type 

This section graphically represents the number of Windows, W3C, Syslog and SNMP 
Traps events collected by GFI Events Manager from a particular machine or network. 

Activity overview 

 
Screenshot 146 - GFI EventsManager Statistics view: Activity Overview 

This section shows: 

 The total number of Windows, W3C, Syslog and SNMP Traps events processed 
on a machine by machine basis 

 The date/time of the last event collection performed from every machine. 
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12 Database Operations 

12.1  Introduction 

The Database Operations module in GFI EventsManager provides advanced 
functionality allowing administrators to: 

 Centralize events collected by other remote GFI EventsManager instances into 
one database backend. 

 Optimize GFI EventsManager performance by actively controlling database 
backend growth hence keeping it in good shape. 

 Import and export data to and from GFI EventsManager version 8.x installations 
without data inconsistencies. 

 Import and export events to and from a storage folder minimizing data loads from 
the database. 

12.2  Why is there a need for database maintenance? 

Periodical database maintenance is essential in preventing excessive data growth in 
the database backend. A database which is large in size drastically affects the 
performance of GFI EventsManager; events browsing will be slower and queries will 
take longer to execute. There will also be a negative impact on GFI EventsManager 
ReportPack performance, with reports taking longer to be generated. 

Through GFI EventsManager a number of database operations, referred to as 
maintenance jobs, can be carried out on the database backend. These include: 

 Move to database - Use this operation to move events from the main database 
to the backup database or to another existing database. 

 Export to file - Use this operation to export events from the main database to a 
compressed binary file which can also be encrypted and backed to CD/DVD or 
tape for safekeeping. 

 Import from file - Use this operation to import events from GFI EventsManager 
export files into the main database backend. 

 Delete data - Use this operation to remove events from the main or backup 
database back-ends. 

Filters that determine which events will be affected by the database operation can be 
applied for each operation. 
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Consolidation of events for a WAN 

 
Figure 9: Consolidation of events for a WAN 

In the case of organizations with remote geographical sites, Database Operations 
can be used to consolidate all or part of the events data collected in remote sites on 
to one central database. This is achieved using the „Export to file‟ feature through 
which GFI EventsManager compresses and encrypts the file as well as export the file 
to be processed to a central location. The „Import to file‟ job is executed at the central 
location, importing the events from the remote site into the central database. 

Events for the remote site can then be viewed through the Events Browser. Reports 
with information relevant to the remote site can also be generated using data from 
the central database. 

12.3  Configuring Database Operations 

With GFI EventsManager you can schedule maintenance jobs to be executed on a 
specific day, at a specific time and at specific intervals. 
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Screenshot 147 - Configuring Database Operations 

 

Database maintenance operations may require high utilization of resources 
which can degrade server and GFI EventsManager performance. Thus, it 
is recommended that you schedule maintenance jobs to be executed after 
office hours. This allows you to maximize the availability of your system 
resources during working hours and avoid any possible disruptions to 
workflow. 

To configure Database Operations: 

1. Click on the Configuration tab and select Options. 

2. From the left pane, right-click on the Database Operations node and select 
Properties. 
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Screenshot 148 - Database Operations Options dialog: GFI EventsManager unique identifier 

3. Specify the unique identifier by which this instance of GFI EventsManager will be 
identified on the network. This identifier is used as part of the export file-name during 
„Export to file‟ operations. 
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Screenshot 149 - Database Operations Options dialog: Scheduling options 

4. Click on the Schedule tab to specify: 

 Hours of the day during which maintenance jobs can be executed 

 The interval in hours/days with which maintenance jobs will be executed 

 The scheduled date/time when maintenance jobs will start being executed. 
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12.4  Creating maintenance jobs 

To create a new maintenance job: 

1. Click on the Configuration tab and select Options. 

2. From the left pane, right-click on the Database Operations node and select 
Create new job…  

3. Click Next button. 

 
Screenshot 150 - New job wizard: Job Type dialog 

4. Select the type of maintenance job you want to create and click Next to proceed to 
the configuration dialog. 

5. Specify the required parameters and click Next to proceed to the data filter 
configuration dialog. 
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Screenshot 151 - Data filter dialog: Specifying data filter conditions 

6. Specify which data will be filtered from your database backend. If no filter is 
specified, the selected maintenance job will affect all data within your database 
backend. Click Next to continue. 

 

For more information on how to configure filter conditions, refer to 
Configuring data filter conditions in this manual. 
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Screenshot 152 - Specify when the job will be executed 

7. Specify whether the selected maintenance job should be scheduled or executed 
immediately. 

 

Scheduled jobs are executed according to interval settings configured in 
the „Database Operations‟. 

 

Selected maintenance jobs will be executed only once. 

8. Click Finish to finalize your configuration settings. 

12.5  Move to database 

To create a maintenance job which moves events between the main database and 
any other target database: 

1. Launch the „New job wizard‟ dialog; select the Move to database option. 
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Screenshot 153 - New job wizard: Move to database 

2. Specify the database to which events will be moved. This should be either the 
backup database or another accessible database on the SQL Server hosting the 
main database. 

3. Specify the frequency in hours/days at which events will be moved from the main 
database. 

4. Click Next to bring up the data filter conditions dialog. 

5. Configure the data filter conditions that will be applied for the „Move to database‟ 
job. If you do not set any data filter conditions, than all events older than the specified 
period will be moved. Click Next to continue. 

 

For more information on how to configure filter conditions, refer to 
Configuring data filter conditions section in this manual. 

6. Specify whether the maintenance job should be scheduled or executed 
immediately. 

7. Click on Finish to finalize configuration of the new „Move to database‟ job. 

12.6  Export to file 

To export events from the main database to a binary file: 

1. Launch the „New job wizard‟ and select the Export to file option. 
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Screenshot 154 - New job wizard: Export to file 

2. Specify the target folder where the exported file will be stored. Use the UNC 
notation to specify remote paths. 

 

Ensure that GFI EventsManager has administrative privileges over the 
specified target folder. 

3. Specify the frequency in hours/days at which events will be exported from the main 
database. 

4. Click Next to bring up the data protection dialog. 
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Screenshot 155 - New job wizard: Export to file using encryption 

5. Define whether the exported events data will be encrypted, specify the password 
to be used for decryption and click Next to proceed to the data filter dialog. 

 

It is recommended that files to be exported are always encrypted using 
strong passwords. 

6. Configure the data filter conditions that will be applied for „Export to file‟ jobs. If you 
do not set any data filter conditions, than all events older than the specified period 
will be exported. Click Next to continue. 

 

For more information on how to configure filter conditions, refer to 
Configuring data filter conditions section in this manual. 

7. Define whether the maintenance job should be scheduled or executed 
immediately. 

8. Click on Finish to finalize your settings. 

Export filename 

The convention used by GFI EventsManager to name the export file is shown and 
described below: 

 [ESM ID]_[Job ID]_[Date From]_[Date To].EXP 
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 ESM ID - refers to the unique identifier given to each GFI EventsManager 
instance running in the organization. 

 Job ID - refers to the unique identifier given to each maintenance job created. 

 Date From - refers to the date of the earliest event exported. 

 Date To - refers to the date of the latest event exported. 

 .EXP - this is the file extension given to all export files. 

The following is an example of an export filename: 

SERVER01_0051_20061020_20061025.EXP 

12.7  Import from file 

To import events from a file or from the storage folder into the main database: 

1. From the New job wizard dialog, select the Import from file option. 

 
Screenshot 156 - New job wizard: Import from file 

2. Specify from which folder to import the files. Select to import from: 

 The main file backend. For more information on how to configure the storage 
folder, refer to Configure storage folder. 

 Other folder. 



 

GFI EventsManager manual Database Operations  171 

 

Ensure that GFI EventsManager has administrative privileges over the 
specified folder. 

 

When Other folder is selected, GFI EventsManager will import all files 
having a .EXP extension. 

3. Click Next to proceed to the data protection dialog. 

 
Screenshot 157 - New job wizard: Import from file decryption 

4. Specify the password with which events data will be decrypted and click Next to 
proceed to the data filter dialog. 

 

Use the same password used for the encryption of your events data. 

 

Data encryption is not applicable when importing events from the storage 
folder. 

5. Configure the data filters that will be applied against the imported file and click 
Next to continue. 

 

Use data filters to define which events will be imported into the main 
database. 
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For more information on how to configure filter conditions, refer to 
Configuring data filter conditions section in this manual. 

6. Specify whether the maintenance job should be scheduled or executed 
immediately. 

7. Click on Finish to finalize your settings. 

 

GFI EventsManager will change the file extension of all successfully 
imported files from .EXP to .IMP. 

12.8  Delete data 

To remove events from the main database: 

1. From the New job wizard dialog, select the Delete data option. 

 

Important events should be backed up using Move to database or Export 
to file before deleting logs. 

 
Screenshot 158 - New job wizard: Delete data 

2. Specify whether events will be deleted from the Main database or from the Backup 
database. 
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3. Specify the frequency in hours/days at which events will be deleted from the 
main/backup database. 

4. Click Next to bring up the data filter conditions dialog. 

5. Configure the data filter conditions that will be applied for the „Delete data‟ job. If 
you do not set any data filter conditions, than all events older than the specified 
period will be deleted. Click Next to continue. 

 

For more information on how to configure filter conditions, refer to 
Configuring data filter conditions in this manual. 

6. Specify whether the maintenance job should be scheduled or executed 
immediately. 

7. Click on Finish to finalize configuration of the new „Delete data‟ job. 

12.9  Configuring data filter conditions 

Use data filter conditions to specify which events will be affected by the maintenance 
job. Only events which match the specified criteria will be processed, moved, 
exported, deleted or imported. 

Filters can be created for all log types supported by GFI EventsManager. 

  
Screenshot 159 - Data filter dialog 
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To specify which events are affected by maintenance jobs, click on the Filter button 
in the data filter dialog. This dialog is available through the „New job wizard‟. 

Example: Windows Event Log filter 

Export events from the Windows Event Log with the following conditions: 

 Log type: Security 

 Event ID: 540 - Successful logon 

 User: administrator 

 Event Type: Error. 

Configure your filter parameters as shown in the „Edit filter‟ dialog shown below: 

 
Screenshot 160 - Creating a filter for Windows events: Edit filter dialog 

Click Ok to finalize filter configuration. 
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Advanced conditions 

 
Screenshot 161 - Advanced Filter settings 

From the Edit filter dialog you can also set advanced filter conditions. Through this 
dialog you can also create and apply filters on all events data fields used by GFI 
EventsManager. 

 

Filters can also be applied on maintenance jobs after they have been 
created. For more information refer to Editing a maintenance job section. 
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12.10  Viewing scheduled maintenance jobs 

 
Screenshot 162 - Viewing scheduled maintenance jobs 

To view maintenance jobs created: 

1. Click on the Configuration tab and select Options. 

2. From the left pane, select the Database Operations node. Scheduled 
maintenance jobs will be displayed in the right pane. 

Job activity status 

 
Screenshot 163 - Job activity status 

To view the progress of maintenance jobs that are being processed click on the 
Status tab and select the Job Activity dashboard view. The status of all 
maintenance jobs will be displayed in the Maintenance Jobs section. 

12.11  Editing a maintenance job 

You can make changes to maintenance job parameters for jobs scheduled. 
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1. Click on the Configuration tab and select Options. 

2. From the left pane, select the Database Operations node. 

3. From the right pane, right-click on the maintenance job to edit and select 
Properties. 

 
Screenshot 164 - Editing a maintenance job 

4. Configure job properties and click OK to finalize your settings. 

 
Screenshot 165 - Example dialog to edit a scheduled job 



 

178  Database Operations GFI EventsManager manual 

12.12  Changing maintenance job priority 

 
Screenshot 166 - Maintenance job priorities 

By default maintenance jobs are executed according to the sequence with which the 
jobs are created (First-in-First-out). Thus the priority of maintenance jobs is 
determined by the sequence in which jobs are executed. 

To increase or decrease the priority of a maintenance job: 

1. Click on the Configuration tab and select Options. 

2. From the left pane, select the Database Operations node. 

3. From the right pane, right-click on the maintenance job and select Increase 
Priority or Decrease Priority accordingly. 

12.13  Deleting a maintenance job 

Scheduled maintenance jobs awaiting execution can also be deleted. 

1. Click on the Configuration tab and select Options. 

2. From the left pane, select the Database Operations node. 

3. From the right pane, right-click on the maintenance job to delete and select 
Delete. 

 

Before deleting maintenance jobs ensure that  before deleting data, 
all data is backed up. 
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13 Miscellaneous 

13.1  Enabling permissions on target computers manually 

This section describes how to configure permissions and ports that are required by 
GFI EventsManager manually. This process has to be done on each machine to 
scan. 

 

In a Windows 2003 or 2008 Active Directory environment, settings can be 
deployed automatically via Group Policy Object (GPO). For more 
information refer to Setting permissions on target computers automatically 
via GPO. 

13.1.1 Microsoft Windows XP 

To enable permissions and open the required ports on Microsoft Windows XP target 
machines: 

1. Click Start ► Control Panel ► Windows Firewall ► Exceptions tab.  

 
Screenshot 167 – Firewall rules on Microsoft Windows XP 

2. Enable File and Printer Sharing from the Programs and Services list. 
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3. Click OK to apply changes and close. 

13.1.2 Microsoft Windows Vista 

Step 1: Enable Firewall permissions 

To manually enable firewall rules on Microsoft Windows Vista: 

1. Click Start ► Control Panel ► Security and click Allow a program through 
Windows Firewall from the left panel. 

2. Select Exceptions tab and from Allowed programs and features list, enable the 
following rules: 

 Remote Event Log Management 

 File and Printer Sharing 

 Network Discovery 

3. Click Apply to apply changes. 

Step 2: Enable additional auditing features 

1. From a command prompt key in secpol.msc and press Enter. 

2. From the Security Settings node, expand Local Policies ► Audit Policy. 

 
Screenshot 168 - Local security policy window 

3. From the right panel, double click Audit object access. 
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Screenshot 169 – Audit object access Properties 

4. From the Audit object access Properties, select Success and Failure and click 
OK. 

5. From the right panel, double click Audit Process tracking. 
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Screenshot 170 – Audit process tracking Properties 

6. From the Audit process tracking Properties, select Success and Failure and 
click OK. 

7. From the right panel, double click Audit account management. 

8. From the Audit process tracking Properties, select Success and Failure and 
click OK. 
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Screenshot 171 – Audit account management properties 

9. From the right panel, double click Audit system events. 

10. From the Audit process tracking Properties, select Success and Failure and 
click OK. 
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Screenshot 172 – Audit system events properties 

11. Close the Local Security Policy window. 

13.1.3  Microsoft Windows 7 

Step 1: Enable Firewall permissions 

To manually enable firewall rules on Microsoft Windows 7: 

1. Click Start ► Control Panel ► System and Security and click Allow a program 
through Windows Firewall, under Windows Firewall category. 
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Screenshot 173 – Allowed programs in Microsoft Windows Vista or later  

2. From Allowed programs and features list, enable the following rules: 

 Remote Event Log Management 

 File and Printer Sharing 

 Network Discovery 

3. Select Domain, Private and Public for each rule mentioned above. 

4. Click OK to apply changes. 

Step 2: Enable additional auditing features 

1. From command prompt key in secpol.msc and press Enter. 
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2. From the Security Settings node, expand Local Policies ► Audit Policy. 

 
Screenshot 174 - Local security policy window 

3. From the right panel, double click Audit object access. 

4. From the Audit object access Properties, select Success and Failure and click 
OK. 
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Screenshot 175 – Audit object access Properties 

5. From the right pane, double click Audit Process tracking. 

6. From the Audit process tracking Properties, select Success and Failure and 
click OK. 



 

188  Miscellaneous GFI EventsManager manual 

 
Screenshot 176 – Audit process tracking Properties 

7. From the Audit process tracking Properties, select Success and Failure and 
click OK. 

8. From the right panel, double click Audit account management. 

9. From the Audit process tracking Properties, select Success and Failure and 
click OK. 
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Screenshot 177 – Audit account management properties 

10. From the right panel, double click Audit system events. 

11. From the Audit process tracking Properties, select Success and Failure and 
click OK. 
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Screenshot 178 – Audit system events properties 

12. Close the local Security Policy window. 

13.1.4 Microsoft Windows Server 2003 

Enable Firewall permissions 

To manually enable firewall rules on Microsoft Windows Server 2003:  

1. Click Start ► Control Panel ► Windows Firewall and select Exceptions tab. 
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Screenshot 179 – Enable firewall rules in Microsoft Windows Server 2003  

2. From Programs and Services list, enable File and Printer Sharing. 

3. Click OK to apply changes and close. 

13.1.5 Microsoft Windows Server 2008 (including R2) 

Enable firewall permissions 

To manually enable firewall rules on Microsoft Windows Server 2008 (including R2):  

1. Click Start ► Control Panel ► Security and Allow a program through 
Windows Firewall under Windows Firewall category. 

2. In the list of programs, enable the following: 

 File and Printer Sharing 

 Network Discovery 

 Remote Event Log Management 
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Screenshot 180 – Firewall rules on Microsoft Windows Server 2008 

 

In Windows Server 2008 R2, ensure to select Domain, Private and Public 
for each rule mentioned above. 

3. Click OK to apply changes. 
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13.2  Setting permissions on target computers automatically via 
GPO 

13.2.1 Windows Server 2003 

To open ports and enable permissions on all domain clients using Microsoft Windows 
Server 2003 domain controller:  

1. Click Start ► Run, key-in mmc and click OK. 

2. Click File ► Add/Remove Snap-in and click Add. 

3. Locate and select Group Policy Object Editor and click Add. 

4. Click Browse, select Default Domain Policy and click OK. 

5. Click Finish. 

6. Select Group Policy Object Editor again and click Add. 

7. Click Browse, double click Domain Controllers folder and select Default Domain 
Controllers Policy. Click OK. 

8. Click Finish and Close. 

9. From the Console Root, expand Default Domain Policy ► Administrative 
Templates ► Network ► Network Connections ► Windows Firewall ► Domain 
Profile. 

 
Screenshot 181 – Domain Policy console in Microsoft Windows Server 2003 

10. From the Settings list, right click Windows Firewall: Allow file and printer 
sharing exception and select Properties. 

11. From the Settings tab, select Enabled and click OK. 
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12. Repeat steps 9 to 11 for Default Domain Controllers Policy. 

13. Click File ► Save to save the management console. 

 

The group policy will be applied the next time each client machine is 
started. 

13.2.2 Windows Server 2008 (including R2) 

Firewall permissions 

To enable permissions on all domain clients: 

1. Click Start ► Administrative Tools ► Group Policy Management. 

2. Expand Group Policy Management ► Forest ► Domains ► <Domain name> 
► Group Policy Objects. 

 
Screenshot 182 – Group Policy Management in Microsoft Windows Server 2008 R2 

3. Right click Default Domain Policy and select Edit. 
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4. Expand Computer Configuration ► Policies ► Windows Settings ► Security 
Settings ► Windows Firewall with Advanced Security, right click Inbound Rules 
and select New Rule… 

 
Screenshot 183 – Group Policy Management Editor 

5. In the New Inbound Rule Wizard, select Predefined and select File and Printer 
Sharing.  
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Screenshot 184 – Predefined rules  

6. Click Next. 

7. Select all rules and click Next. 

8. Select Allow the connection and click Finish 

9. Repeat steps 5 to 8 for each of the following rules: 

 Remote Event Log Management 

 Network discovery 

10. From Group Policy Management Editor, expand Computer Configuration ► 
Policies ► Windows Settings ► Security Settings ► Windows Firewall with 
Advanced Security, right click Outbound Rules and select New Rule… 

11. Repeat Steps 5 to 9 while at step 9 enable only Network Discovery. 

12. Close Group Policy Management Editor. 
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13. From Group Policy Management, expand Group Policy Management ► Forest 
► Domains ► <Domain name> ► Default Domain Controllers Policy. 

14. Repeat steps 4 to 13. 

15. Close Group Policy Management. 

NOTE: The group policy will be applied the next time each client machine is started. 

13.3  Disable UAC to scan target machines 

When GFI EventsManager is configured to collect events using a local account target 
machines must have User Account Control (UAC) disabled. To disable UAC on 
Microsoft Windows Vista machines or later: 

1. Click Start ► Run, key-in secpol.msc and press Enter. 

2. From the Security Settings, expand Local Policies and click Security Options. 

3. Right click User Account Control: Run all administrators in Admin Approval 
Mode and select Properties. 

 

Screenshot 185 – Predefined rules  

4. From the Local Security Settings tab, select Enabled and click OK.  

5. Close the Local Security Policy window.  
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13.4  Command line operations 

GFI EventsManager provides you with three command line tools through which you 
can perform data export and import functions. These three tools are: 

 Exportdata.exe: Exports data from an ESM 8 database using database 
operations engine 

 Importdata.exe: Imports data into an EMS 8 database using database 
operations engine 

 Importsettings.exe: Imports configuration from a data folder or from a 
configuration export file (.esmbkp) and is used mostly from installer when 
preserving configuration 

 ExportSettings.exe: Exports configuration settings from GFI EventsManager 
installation to a configuration file. 

 ExportRules.exe: Creates an HTML document that contains details on the 
processing rules configured in a GFI EventsManager installation. 

13.4.1 Exportdata.exe 

Use this tool to export data from the GFI EventsManager database to binary file. 

Usage: 

exportdata.exe <parameters list> 

Parameter Mandatory/
Optional 

Description 

/folder: <path & foldername> Mandatory Defines folder where the data file will be 
stored.  

IMPORTANT: The folder must be 

created before executing the command. 

/period: <number of hours> Optional Exports events older than the number of 
hours: Default = 7 days 

/password: <file password> Optional Sets an encryption password 

/delete Optional Deletes the events after export 

/movetodb:<database name> Optional Moves the events to another database on 
the same server. If no name is specified, 
the backup database will be used 

NOTE: Any parameter that contains spaces must be enclosed in double quotes (“). 

Example: 

Exportdata.exe /folder:c:\exportfiles /period:240 /password:aip112sK 

Where data is exported with the following details: 

 A folder called exportfiles, located at c:\ 

 Data older than 10 days (240hours) 

 Encrypt using password aip112sK 
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13.4.2 Importdata.exe 

Use this tool to import data in binary files to the GFI EventsManager database. 

Usage: 

importdata.exe <parameters list> 

Parameter Mandatory/ 
Optional 

Description 

/folder:<path & foldername> Mandatory Defines the folder where the data file is 
stored. 

/password:<file password> Optional Defines the password that will be used to 
decode files; if not specified, no 
password will be used 

/dbserver:<databaseserver 
location > 

Optional Defines the database server where the 
destination database lies. If not specified, 
the database details specified in GFI 
EventsManager will be used. 

/dbname:<database name> Optional Defines the destination database name. 
If not specified, the database name 
specified in GFI EventsManager will be 
used. 

/dbuser:<username> Optional Defines the user name used to connect 
to database. If not specified, Windows 
authentication will be used. 

/dbpass:<password> Optional Defines the password used to connect to 
destination server/database. If none is 
specified, password is ignored. 

NOTE: Any parameter that contains spaces must be enclosed within double quotes 
(“). 

Example: 

importdata.exe /folder:c:\exportfiles /password:aip112sK /dbserver:192.168.3.55 
/dbname:mainesmdb /dbuser:sa /dbpass:sapwd 

Where data is imported with the following details: 

 From folder called exportfiles, located at c:\ 

 Decrypted using password aip112sK 

 Saved to database on server with I.P. address 192.168.3.55, with database 
name: mainesmdb and with the following login credentials: username: sa and 
password sapwd. 

13.4.3 ImportSettings.exe 

Use this tool to import GFI EventsManager configurations previously exported. 

Usage: 

importsettings.exe <parameters list> 
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Parameter Mandatory
/Optional 

Description 

/operation:<operation> Mandatory Defines the operation to perform, either 
importfolder or import file 

/destination:<destination path> Optional Defines the destination folder where the 
configuration will be imported 

/sourceFile:<filename> Optional Defines the name of the file that contains the 
exported GFI EventsManager configuration. 

/sourceFolder:<folder 
name/path> 

Optional Defines the name of the folder that contains 
the exported GFI EventsManager 
configuration. 

NOTE: Any parameter that contains spaces must be enclosed in double quotes (“). 

Example: 

importsettings.exe /operation:importfolder: /destination: c:\esm\data /sourcefolder: 
c:\esm\old 

Where data is imported with the following details: 

 Operation is importfolder to c:\esm\data from folder c:\esm\old 

13.4.4 ExportSettings.exe 

Use this tool to export the GFI EventsManager configuration. 

Usage: 

exportsettings.exe <parameters list> 

Parameter Mandatory
/Optional 

Description 

/destination:<filename> Mandatory Defines the file where the configuration will 
be exported 

/folder:<folder> Optional To export from an alternative folder. 

NOTE: Any parameter that contains spaces must be enclosed in double quotes (“). 

Example: 

exportsettings.exe /destination:”c:\export” 

Where data is exported with the following details: 

 Export file located in C:\export.esmbkp 

13.4.5 ExportRules.exe 

Use this tool to create an HTML document containing all processing rules. 

Usage: 

ExportRules.exe 

The HTML document is exported to: 



 

GFI EventsManager manual Miscellaneous  201 

<GFI EventsManager home Directory> \ Configuration Reports \ Reports <current 
date>  

Example: 

C:\Program Files\GFI\EventsManager 8\Configuration reports\Reports 2010-02-23\ 

 Select a computer from the HTML document to display all processing rules 
related to the computer selected. 

 Select a processing rule from the HTML document to display the conditions that 
apply to the rule selected. 

For more information, refer to http://kbase.gfi.com/showarticle.asp?id=KBID003785. 

13.4.6 Customizing unique identifiers 

GFI EventsManager enables you to customize the unique identifiers of the GFI 
EventsManager installation. This enables you to import the same configuration into 
separate without incurring duplicate GFI EventsManager instance IDs. 

To configure new GFI EventsManager unique identifiers add the following option to 
command line options of importdata.exe 

Parameter Mandatory/
Optional 

Description 

/id:<new_id> Optional Defines the new ESM instance id set after importing 
the configuration. Use this parameter on only if you 
only want to change the ESM instance id; if no 
value is specified the existing ESM instance id will 
be preserved.  

13.5  Product licensing 

For information on GFI EventsManager licensing refer to: 

http://www.gfi.com/page/13789/products/gfi-
eventsmanager/pricing/licensing/licensing 

13.5.1 View license details 

To check your licensing details: 

1. Click on the General tab. 

2. From the left pane, click on the Licensing option. Licensing details will be 
displayed in the right pane of the management console. 

3. To view license distribution details click on Show Details. This will show the 
number of event sources configured and respective license type (i.e. Workstation or 
Server). 

13.5.2 Update license key 

To enter your license key after installation: 

1. Click on the General tab. 

http://kbase.gfi.com/showarticle.asp?id=KBID003785
http://www.gfi.com/page/13789/products/gfi-eventsmanager/pricing/licensing/licensing
http://www.gfi.com/page/13789/products/gfi-eventsmanager/pricing/licensing/licensing
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2. From the left pane, right-click on the Licensing option and select Edit license 
key…. 

 
Screenshot 186 - Update license key 

3. Specify your license key details. 

4. Click OK to finalize your settings. 

13.5.3 Update license type 

To change the type of license allocated to a specific event source: 

1. Bring up the (computer/computer group) properties dialog and click the Licensing 
Type tab. 

2. By default event sources inherit their licensing type from parent group (i.e. use the 
license type configured in parent group properties). To change license type select the 
Server License or Workstation option accordingly. 

13.6  Version information 

To check your version information details: 

1. Click on the General tab. 

2. Click the Version Information option. The version information details will be 
displayed in the right pane. 
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Screenshot 187 - Version Information screen 

13.6.1 Checking for newer builds 

To check for newer builds of GFI EventsManager: 

1. Click on the General tab. 

2. From the left pane, right-click on the Version Information option and select 
Check for newer builds…. 

 





 

GFI EventsManager manual Troubleshooting  205 

14 Troubleshooting 

14.1  Introduction 

The troubleshooting chapter explains how you should go about resolving any 
software issues that you might encounter. The main sources of information available 
to users are: 

 The manual - most issues can be solved by reading this manual 

 GFI Knowledge Base articles 

 Web forum 

 Contacting the GFI Technical Support 

14.2  Common issues 
Issue Description and solution 

Error message: Not 

connected to the database 
or connection was lost. 

Description 

This error is encountered when GFI EventsManager is unable to 
connect with the SQL database or the database connection was 
interrupted. 

Solution 

The following links contain information on how this issue can be 
solved. 

How do I debug „Failed to connect to database‟? 

http://kbase.gfi.com/showarticle.asp?id=KBID002855 

How do I configure SQL Server 2005/2008 to accept SQL 
Authentication? 

http://kbase.gfi.com/showarticle.asp?id=KBID002804 

How do I configure SQL Server 2000 to accept SQL Authentication?  

http://kbase.gfi.com/showarticle.asp?id=KBID002805 

Enabling TCP/IP on Microsoft SQL Server 2005 

http://kbase.gfi.com/showarticle.asp?id=KBID002920 

How to create a new database in Microsoft SQL Server 

http://kbase.gfi.com/showarticle.asp?id=KBID003379 

Error message: Primary 

Filegroup Full. 

Description 

This error is encountered when GFI EventsManager database 
backend has a maximum file size limitation and is unable to store 
any further data. 

Solution 

Configure the database backend to allow larger file size. This can 
be done on both Microsoft SQL Server and Microsoft SQL Server 
Express edition. For more information on how to change the 
maximum file size, refer to 

http://kbase.gfi.com/showarticle.asp?id=KBID003670 

http://kbase.gfi.com/showarticle.asp?id=KBID002855
http://kbase.gfi.com/showarticle.asp?id=KBID002804
http://kbase.gfi.com/showarticle.asp?id=KBID002805
http://kbase.gfi.com/showarticle.asp?id=KBID002920
http://kbase.gfi.com/showarticle.asp?id=KBID003379
http://kbase.gfi.com/showarticle.asp?id=KBID003670
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Issue Description and solution 

Error message: Could not 

complete cursor operation 
because the table schema 
changed after the cursor 
was declared‟ 

Description 

This error is encountered when the administrator is  performing 
maintenance tasks on the GFI EventsManager databases while the 
GFI EventsManager service is running. 

Solution 

1. Stop GFI EventsManager service 

2. Perform the maintenance tasks in Microsoft SQL server 

3. Restart GFI EventsManager Service once the Microsoft SQL 
maintenance tasks are finished.  

To avoid this, ensure that GFI EventsManager service is stopped 
whilst performing any maintenance tasks on the GFI 
EventsManager database. 

For more information refer to 

http://kbase.gfi.com/showarticle.asp?id=KBID003011 

Error message 1: 

Error connecting to 
machine MACHINENAME, 
Error 0x35, Message: The 
network path was not 
found. 

Error message 2: 

Error connecting to 
machine MACHINENAME, 
Error 0x52E, Message: 
Logon failure: unknown 
user name or bad 
password. 

Error message 3: 

Critical error encountered: 
A network-related or 
instance-specific error 
occurred while establishing 
a connection to SQL 
Server. The server was not 
found or was not 
accessible. Verify that the 
instance name is correct 
and that SQL Server is 
configured to allow remote 
connections. (provider: 
Named Pipes Provider, 
error: 40 - Could not open 
a connection to SQL 
Server) 

Error message 4: 

Unexpected error when 
connecting to machine 
MACHINENAME; remote 
W3C logs path is: 
PATH\*.* 

Description 

These errors are encountered when GFI EventsManager tries to 
collect events from a machine that is not accessible over the 
network or the credentials are invalid. 

Possible solution 1 

1. Check that the credentials are correct 

2. Check that the machine name or IP address are correct 

3. Try to collect events 

Possible solution 2 

When using a personal firewall, check that the required firewall ports 
are configured to allow traffic. 

For more information refer to 

http://kbase.gfi.com/showarticle.asp?id=KBID002770 

When using Windows firewall, check that all the required firewall 
permissions are enabled. 

For more information refer to 

http://kbase.gfi.com/showarticle.asp?id=KBID003688 

Possible solution 3 

Ensure that GFI EventsManager is installed on a supported 
environment. For more information on where GFI EventsManager 
can be installed, refer to 

http://kbase.gfi.com/showarticle.asp?id=KBID002842 

http://kbase.gfi.com/showarticle.asp?id=KBID003011
http://kbase.gfi.com/showarticle.asp?id=KBID002770
http://kbase.gfi.com/showarticle.asp?id=KBID003688
http://kbase.gfi.com/showarticle.asp?id=KBID002842
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Issue Description and solution 

No event logs are being 
collected by GFI 
EventsManager. 

Description 

This issue can be caused by various factors and is dependent on 
the environment where GFI EventsManager is installed. For a 
checklist on how to resolve this issue, refer to 

http://kbase.gfi.com/showarticle.asp?id=KBID002819 

Error message 1: 

A timeout was reached 
(60000 milliseconds) while 
waiting for the GFI 
EventsManager service to 
connect. 

Error message 2: 

Error 1053: The service 
did not respond to the start 
or control request in a 
timely fashion. 

Description 

The GFI EventsManager executables are digitally signed by default. 
When trying to start the service, the application must download the 
Certificate Revocation List to authenticate. If the download fails due 
to network connectivity or security reasons the service will fail to 
start by timing out. 

Possible solution 1 

Increase the default service timeout settings as described in the 
following Microsoft knowledgebase article 

http://support.microsoft.com/kb/941990 

Possible solution 2 

Disable Certificate revocation list (CRL). 

1. Download Microsoft Setreg application from 

http://ftp.gfisoftware.com/support/setreg.zip 

2. Login to the GFI EventsManager server using the GFI 
EventsManager service user.  

3. Open command prompt  

4. Change the directory to the directory storing setreg.exe 

5. Run the following command: 

setreg.exe 3 FALSE 

Note: The setting above can be reverted by running the following 

command: setreg.exe 3 TRUE   

For more information refer to 

http://kbase.gfi.com/showarticle.asp?id=KBID003365 

Error message:  

The maintenance job 
failed! 

Description 

GFI EventsManager uses an ASP.Net Library called GZipStream to 
compress and export data from the GFI EventsManager databases. 
GZipStream is unable to compress data larger than 4GB. GFI 
EventsManager will return this error when trying to export data 
which is larger than 4GB. 

Solution 

In order to export the data required, use the GFI EventsManager 
Advanced Filters to reduce the number of Events exported. 
Therefore eventually reducing the size of the data which is being 
compressed. For more information, refer to Configuring data filter 
conditions section in this manual.  

http://kbase.gfi.com/showarticle.asp?id=KBID002819
http://support.microsoft.com/kb/941990
http://ftp.gfisoftware.com/support/setreg.zip
http://kbase.gfi.com/showarticle.asp?id=KBID003365
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Issue Description and solution 

Error message:  

Event Log Records could 
NOT be retrieved: The 
RPC server is unavailable 

 

Description 

This error may occur if:  

 The remote computer may be shut down.  

 There may be a network hardware problem.   

 There may be no common transports.  

 The remote computer does not exist.  

 A DNS entry does not exist for the remote computer in the DNS 
server (Try pinging the remote machine from another computer 
by using its host name and not its IP).  

Investigate each possible problem and make the necessary 
changes. Then try to collect events from target computers.  

For more information, refer to 

http://kbase.gfi.com/showarticle.asp?id=KBID002820 

GFI EventsManager 
reports an error number 
1069. 

Description 

When installed, GFI EventsMananger asks for a valid username and 
password. This error is encountered when an invalid password is 
submitted in the installation wizard. 

Solution 

1.Click Start ► Run, key-in services.msc and click Ok. This will 
launch Services window.  

2. Double Click on the GFI EventsManager service.  

3. Select the Log On tab.    

4. Ensure that the This account radio box is selected.    

5. Key-in a valid password for the specified User account.  

6. Press OK to close the Properties window.  

7. Close Services window. 

14.3  Knowledge Base 

GFI maintains a Knowledge Base, which includes answers to the most common 
problems. If you have a problem, please consult the Knowledge Base first. The 
Knowledge Base always has the most up-to-date listing of technical support 
questions and patches. To access the Knowledge Base, visit http://kbase.gfi.com/. 

14.4  Web Forum 

User to user technical support is available via the web forum. The forum can be 
found at: http://forums.gfi.com/. 

14.5  Request technical support 

If you have referred to this manual and our Knowledge Base articles, and you still 
cannot solve issues with the software, contact the GFI Technical Support team by 
filling in an online support request form or by phone. 

 Online: Fill out the support request form on: 
http://support.gfi.com/supportrequestform.asp. Follow the instructions on this 
page closely to submit your support request. 

http://kbase.gfi.com/showarticle.asp?id=KBID002820
http://kbase.gfi.com/
http://forums.gfi.com/
http://support.gfi.com/supportrequestform.asp
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 Phone: To obtain the correct technical support phone number for your region 
please visit: http://www.gfi.com/company/contact.htm. 

NOTE: Before you contact our Technical Support team, please have your Customer 
ID available. Your Customer ID is the online account number that is assigned to you 
when you first register your license keys in our Customer Area at: 
http://customers.gfi.com. 

We will answer your query within 24 hours or less, depending on your time zone. 

14.6  Build notifications 

We strongly suggest that you subscribe to our build notifications list. This way, you 
will be immediately notified about new product builds. To subscribe to our build 
notifications, visit: 

http://www.gfi.com/pages/productmailing.htm. 

http://www.gfi.com/company/contact.htm
http://customers.gfi.com/
http://www.gfi.com/pages/productmailing.htm
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15 Glossary 

Table 8 below describes all common terms used in this manual.  

Table 8 - Terms used in this manual 

Term Definition 

Audit process 
tracking 

Generates events which track actions such as programs which are 
launched, closed, as well as other indirect object access information which 
contain important security information. For more information, refer to 
http://technet.microsoft.com/en-us/library/cc775520(WS.10).aspx 

Actions The activity that will be carried out as a result to events matching specific 
conditions. For example you can trigger actions whenever an event is 
classified as critical. Actions supported by GFI EventsManager include 
Email alerts, event archiving and execution of scripts.  

Alerts Notifications which inform recipients that a particular event has occurred. 
GFI EventsManager can generate Email alerts, SMS alerts and Network 
alerts. 

Archive A collection of events stored in the SQL Server based database backed of 
GFI EventsManager. 

Audit account 
management 

Generates events when account management operations are done such 
as create/delete a user account or group, enable/disable a user account 
and set/change a user password. For more information, refer to 
http://technet.microsoft.com/en-us/library/cc737542(WS.10).aspx 

Audit system events Generates events when important system events happen such as user 
restarts or shuts down the target computer or when an event occurs that 
affects the security log. For more information, refer to 

http://technet.microsoft.com/en-us/library/cc782518(WS.10).aspx 

COM+ Network 
Access 

Enable this firewall permission to allow client machines to access 
applications or services that resides on the server. This allows GFI 
EventsManager to access resource from all servers. For more information 
about this permission, refer to http://technet.microsoft.com/en-
us/library/cc731967.aspx 

Email alerts Email notifications which inform recipients that a particular event has 
occurred. To enable email alerts, you must have access to an active mail 
server. 

Event classification The categorization of events as Critical, High Medium, Low or Noise. 

Event logs A collection of entries which describe events that occurred on the network 
or on a computer system. GFI EventsManager supports different types of 
event logs including: Windows Event Log, W3C Logs, Syslog, SNMP Traps 
and SQL Server audit events. 

Event processing 
rules 

A set of instructions which are applied against an event log. 

http://technet.microsoft.com/en-us/library/cc775520(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc737542(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc782518(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc731967.aspx
http://technet.microsoft.com/en-us/library/cc731967.aspx
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Term Definition 

File and Printer 
sharing 

Enable this firewall permission to allow GFI EventsManager to access 
events definitions on target machines. For more information, refer to 
http://technet.microsoft.com/en-us/library/cc779133(WS.10).aspx 

Management 
Information Base 

A MIB is the equivalent of a data dictionary or codebook. It associates 
object identifiers (OIDs) with a readable label and various other parameters 
related to an active network object such as a router. Its main function is to 
assemble and interpret SNMP messages transmitted from SNMP-enabled 
network devices. The information stored in MIBs is organized hierarchically 
and is normally accessible using a protocol such as SNMP.  

Network alerts Network messages (known as Netsend messages) which inform recipients 
that a particular event has occurred. These messages are sent through an 
instant messenger system/protocol and are shown as a popup in the 
system tray of the recipient‟s desktop. To setup network alerts, you must 
specify the name or IP of the computers where the Netsend messages will 
be sent. 

Network discovery Enable this firewall permission to allow GFI EventsManager to gather 
information about connected machines on the network that can be 
scanned. For more information, refer to http://technet.microsoft.com/en-
us/library/cc181373.aspx 

Noise Repeated log entries which report the same event.  

Object auditing Enable this auditing feature to audit events of users accessing objects 
(example, files, folder and printer). 

For more information, refer to 

http://technet.microsoft.com/en-us/library/cc976403.aspx 

Object auditing Enable this auditing feature to audit tracking information (example, 
program activation, process exit and indirect object access). For more 
information, refer to http://technet.microsoft.com/en-
us/library/cc775520(WS.10).aspx 

Remote Event Log 
Management 

Required to allow GFI EventsManager to access and collect events from 
remote machines. For more information, refer to 
http://technet.microsoft.com/en-us/library/cc766438.aspx 

Rule-set folder The folder which contains one or more rule-sets. 

Rule-sets A collection of event processing rules. 

SMS alerts SMS notifications which inform recipients that a particular event has 
occurred. In GFI EventsManager, SMS alerts can be sent through various 
sources including mobile phones with modem capabilities and email-to-
SMS web-based gateways.  

SNMP Object 
Identifier (OID) 

An SNMP object identifier is an address made up of a sequence of „dotted‟ 
numbers (e.g. 1.3.6.1.4.1.2682.1). These numbers uniquely identify and 
locate a specific device (e.g. hub) within the entire network. SNMP OIDs 
are a key component in the assembly of SNMP messages. In fact, an 
SNMP server cannot interpret or assemble messages which don‟t have an 
OID. Individual vendors often create their own MIBs that only include the 
OIDs associated specifically with their device. 

http://technet.microsoft.com/en-us/library/cc779133(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc181373.aspx
http://technet.microsoft.com/en-us/library/cc181373.aspx
http://technet.microsoft.com/en-us/library/cc976403.aspx
http://technet.microsoft.com/en-us/library/cc775520(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc775520(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc766438.aspx
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Term Definition 

SNMP Traps Notifications/alerts generated and transmitted by active network 
components (e.g. hubs, routers and bridges) to SNMP server(s) whenever 
important events such as faults or security violations occur. Data contained 
in SNMP Traps may contain configuration, status as well as statistical 
information such as number of device failures to date. 

Syslog messages Notifications/alerts most commonly generated and transmitted to a Syslog 
server by UNIX and Linux-based systems whenever important events 
occur. Syslog messages can be generated by workstations, servers as well 
as active network devices and appliances such as Cisco routers and Cisco 
PIX firewalls to record failures and security violations amongst other 
activities. 

Unclassified events Events that did not satisfy any of the event processing conditions 
configured in the event processing rules. 

W3C logs W3C is a common log format developed by the World Wide Web 
Consortium. W3C logs are text-based flat files used mainly by web servers 
including Microsoft Internet Information Server (IIS) to record web related 
events such as web logs. 

Windows Event 
Logs 

A collection of entries which describe events that occurred on a computer 
system running Windows OS. 
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